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Regional Flood Information System

A Introduction

The RFIS (Regional Flood Information system) is a time series software that provides a platform for timely
exchange of flood data and information.

The RFIS is developed with the objective of flood observation network in Hindu Kush Region with the
development of regional database for hydrological and meteorological information; thus providing a
common data sharing format for easy dissemination of weather information in the region.
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Regional Flood Information System

Components of RFIS:
The RFIS software intact different modules to provide a platform for the information exchange.

Remote Device Configuration

Data Acquisition Module

Data Management Module

Data Visualization Module
Content/Document Management Module

monNnw >

A. Remote Device Configuration
It is a web-based device configuration application operated through internet. It provides an
interface to configure data loggers and sensors.

[ Data Logger ]

Request for
Setting

@

Provides
Setting

RFIS
Database

Remote Device _—
Configuration System

B. Data Acquisition Module
Data Acquisition Module is a gateway for weather data into RFIS database. It receives data
from field device through internet via HTTP protocol.

Other Data [ Data Logger ]

Sources SMS-to-WEB

/ Gateway

Data Acquisition
Module

2|Page



Regional Flood Information System

C. Data Management Module
The Data Management Module comprises of following components:

e DataEntry
It is a manual data observation entry interface that is intended for addition of
station and its metadata.

e Quality Control
Quality Control is a mechanism for data validation. Data validation is based on
user definable rules. This also provides interface to configure alerts / warning
based on observations received and the rules defined. QC helps to check
correlation between observations for same station or multiple stations. Further, it
provides timely information for errors in sensor and system.

e« Data Aggregation
Data Aggregation is a mechanism for generating derived parameters from basic
parameters. The data aggregation is based on specific rules, data quality and
availability. The aggregated data can also be handled by the QC engine.

e Monitoring
Data Management System also provides a web interface to monitor remote
devices. This generally includes Data monitoring, Power and Battery usage
monitoring which helps in fault finding and trouble shooting of remote devices.
Automatic notification is generated for any error - communication error, device
error, etc.

o Data Rectification / Processing
DMS provides an interface for correcting observations; audit trail and data
download and upload. This module also facilitates manual execution of rule
engine and aggregation engine.

e User Management

D. Data Visualization Module:

RFIS provides a large set of components for visualization of data in different standards and
formats such as:

+ Basic tabular view and graph view for all the parameters
+  Virtual instruments on websites for specific parameters for real time display
+  Map view with Google map integration

The data visualization module provides highly customizable components for user specific
requirements and it is scalable to add further visualization components.

E. Content/Document Management Module:

The Content Management Module is an interface in DMS to manage additional documents,
reports, publications, news, etc related to station and observations. This module can be
integrated with data visualization component to create customizable web pages to display on
public web sites. Further, this module provides basic search and document management
system for repository.

Note: There are separate links for Remote Device Configuration, Data Management
System and Content Management System. Please contact Real Time Solutions for the links.
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Regional flood Information System - Data Management System (DMS)

B Remote Device Configuration

This section familiarizes several web based tools associated with remote device configuration
viz. configuration of data logger and sensors and setting its parameters.

1 Login

W' WSCADA

Enter your credentials to login

Username:

Password:

[ Remember me on this computer

2012 © Real Time Solutions Pvt. Ltd.

Log In

www.wscada.net

In the web browser, enter the link provided by RTS.
Provide you username and password. If login is successful you will see an interface like below.

2 Configuring Project, Station and RTU

2.1 Adding a Project

Click on “+Project” and then on “Add Project “on the right pane. A project details dialog box

will appear.

W' Wscada Configuration

@ & projects

@ (& Users
_ Add Project
® [l Groups

Wscada Configuration Home - Projects

e [strted | Completed Description |

HKH-HYCOS-Nepal
Regional Training
List of projects e

RND Testing

Interface Testing

HKH-HYCOS Bangaldesh
Sirajgunj Station

hkh-bangladesh

e Provide Name of the project

e Provide Start Date, Completion Date
and Description of the project (these
fields are not mandatory).

e Save your project by clicking on “Save”
button.

Project Details...
Mame: Hycos Test Project
Start Date:

Completion Date:

Description:

Save

4|Page
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Regional flood Information System - Data Management System (DMS)

e If saving is successful you will see the project in the project list

W' Wscada Configuration
8 S Projects Wscada Configuration Home - Projects

@ (55 HKH-HYCOS-Nepal
= P Add Project

@ (& Regional Training
@ (B RND Testing
HKH-HYCOS-Nepal

B (5 Interface Testing Regionsl Training

@ (@ HKH-HYCOS RND Testing

@ & HKH-HYCOS Eang° Interface Testing
HKH-HYCOS
HKH-HYCOS Bangaldesh

&S Hycos Test Project

@ &5 Test Project
Sirajgunj Station

@ |3 RTS Training
@ |g@ MNapa
& (&5 SAARC Storm Program

|Hy(05 Test Project

@ B2 RTS TEST @ RTS
B [ rts test
@ (@ Users

@ [ Groups

2.2 Adding Station

W' Wscada Configuration °

8 B Projects

Projects >|Hycos Test Project
8 [ HKH-HYCOS-Nepal 1 1

= =

® % HS-Mulghat
© i AWS-Dhaniata Location | Description _|
® f HS-Bahrabise
© ([ Regional Training
® % ICIMOD-Bubbles-Test Station
S (& RND Testing
® % RTS Office
® % Kurigram
8 (@ Interface Testing
® % Test Station
% Test-Station - 2
& [ HKH-HYCOS
I Gupis
© ([ HKH-HYCOS Bangaldesh

Hycos Test Project Station

Code: 0001

Mame: Kathrmandu

Type: Hydrological E‘
Lecation:

Description:

Save Cancel

=
S (gl Projects
® (@ HKH-HYCOS-Nepal
& (& Regional Training
& (& RND Testing
& (& Interface Testing
& (@ HKH-HYCOS
@ (@ HKH-HYCOS Bangaldesh
(& Sirajgunj Station
(& hkh-bangladesh
&

© (@ Hycos Test Project

% Kathmandu

N ™ N [ e S

2012-04-28 | 0000-00-00

HEH HYCOS Pilot Project

2012-04-16 | 2012-04-21
0000-00-00 | 0000-00-00
2012-04-22 | 2013-04-21

Project for Interface Testing Purpose Only 1

2012-04-22 | 0000-00-00

2012-06-09 | 0000-00-00
-00-00 | 0000-00-00

|oooo—oooo 0000-00-00

In the project list page (image above)
click on the project (1) or click on
“+Projects” in the left panel to expand
the tree and click on the project (2).

To edit this project (3) click on button
“Edit Project” (2).

To add a station click on button “Add
Station” (1) under the project (3).

Provide Station Code. Must be unique
and numeric.

Provide Station Name

Select Station Type

Leave other fields blank and click
“Save”

If saving is successful you will see the
station in the station list page.

Juration

Projects > Hycos Test Project

Add Station Edit Project Add Project

Cote—iame Tpe —iocsion —|Duscipion |
Hydrological

0001 Kathmandu Hydrological
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Regional flood Information System - Data Management System (DMS)

2.3 Adding remote terminal unit (RTU)

e In the station list page (image above) click on the station (1) or click on “+Hycos Test
Project” in the left panel to expand the tree and click on the station (2).

W' Wscada Configuration

S @ Projects Hycos Test Project j Kathmandu °

® (& HKH-HYCOS-Nepal
) I Add RTU I
® & Regional Training

® | Interface Testing

® (@ HKH-HYCOS

® & HKH-HYCOS Bangaldesh
\l Sirajgunj Station
i hkh-bangladesh

B | Hycos Test Project

Kathrmandu

Edit Station 2

e To edit this station (3) click on button “Edit Station” (2).
e Toadd RTU click on button “Add RTU” (1) under the station (3).

General Tab

Add new RTU in Kathmandu

Type: RTDL-11 [=]
MName: RTU-Kathmandu
Code: 8
Primary Server: ICIMOD lz‘
Secondary Server: ICIMOD El
Encryption: AES Iz‘
AES Key:
Confirm AES Key:

Save Cancel

Time Tab

= Select type: RTDL-11, Provide RTU
name and code (code must be
unique and numeric).

= Provide Primary Server : device will
communicate to this server and also
sends parameter readings

» Provide Secondary Server: device
will not communicate with this
server but send parameter readings.

= If you want to enable data
encryption select Encryption “AES”
or else “None”".

This tab is used to enable time synchronization for the device.

Add new RTU in Kathmandu

Auto Sync Time: Enable E

MNTP Time Server: time.windows.com

Sync Interval: 1 hr

Time Zone: GMT (+00:00) [+]
Save Cancel

* Enable “Auto Sync Time"

= Provide NTP (Network Time
Protocol) time server address.
Usually : time.windows.com
This is the location from where the
device synchronizes its time

= Select “Sync Interval”: must be
numeric.

* Time Zone: Device will provide data
in the time zone you specified.
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Regional flood Information System - Data Management System (DMS)

Advance Tab
= |f you enable “Auto Firmware

Add new RTU in Kathmand Update” it will check for the updates
[ Advanced | for the software that is running on
Auto Firmware Update: | Enable =] the device. Checking frequency is
Update Check Interval: hr determined by the “Update Check
Power Supply Records: | Enable =] Interval” and it must be numeric.
Supply Sampling Interval: min
Supply Logging Interval: win ™ 1f you want to record the supply
Data Transfer Frequency: | Power Saving = voltage enable “Power Supply

Records”
e Provide “Supply Sampling Interval”

and “Supply Logging Interval”

* If “Power Saving” is selected as “Data Transfer Frequency”, then data will be
posted in long interval of time whereas data posting is at real time if “Real Time
Posting” is selected.

» [f saving is successful you will see the RTU in RTU list page as shown below:

W' Wscada Configuration
S @ Projects Hycos Test Project > Kathmandu
& [ HKH-HYCOS-Nepal

AJdRTU  Edit Station

I Regional Training

& [ RMD Testing Code  MName Last Activi* | Description
® (& Interface Testing a8 RTU-Kathmandu 1
B & HKH-HYCOS

|l HEH-HYCOS Bangaldesh
kel Sirajgunj Station
ks hkh-bangladesh

el

|l Hycos Test Project

e {4 Kathmandu e
@ ‘{ﬁ‘s [RTDL-11]

2.4 Adding RTU Sensors
* In the RTU list page (image above) click on the RTU (1) or click on “+(station)” in the left
panel to expand the tree and click on the newly added RTU (2).

W' Wscada Configuration

© (& Projects Kathmandu : 8 [RTDL-11] O
Add Alert Download Edit RTU

® [ HKH-HYCOS-Nepal

P - | Add Sensor " Add Parameter | mmunication
® 3 Regional Training

(& RND Testing

- hng Parameters m
(& Interface Testing

(&3 HKH-HYCOS

® L HKH-HYCOS Bangaldesh

ll Sirajgunj Station
(& hkh-bangladesh

[

(&3 Hycos Test Project

e Kathmandu

W3 [RTDL-11]

=  To edit this RTU (3) click on button “Edit RTU"” (2).
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Regional flood Information System - Data Management System (DMS)

= To add a sensor click on button “Add Sensor” (1) under the RTU (3).

Add a sensor in RTU-Kathmandu

Type: OTT Compact Bubbler Sensor (CBS) IE'
501 Address: 0 IZ'
Save Cancel

= Select the type of sensor.
= Settings are provided accordingly to the type of sensor selected.
= Click “Add Parameter” (4).

Add a prameter in RTU-Kathmandu

Sensor: OTT Compact Bubbler Sensor (CBS) El
Parameter: Waterlevel E‘
Mame:

Offset: 0

Sampling Interval: 10 minutes E‘
Logging Interval: 10 mins
Measurement Unit: meters (m) E‘

Save Cancel

= Select the sensor for which parameter/s is/are to be added.

= Selectits corresponding Parameter.

= Provide a Name for the selected parameter.

*  Provide Sampling Interval, Logging Interval and Measurement Unit accordingly.
= If saving is successful you will see the parameter in the list.

3 Communication Setting (Modem setting)
e To setup the communication press button “Communication” (1) (image below).

Kathmandu > 8 [RTDL-11]
Add Sensor Add Parameter | Communication | Add Alert Download Edit RTU

Parameters m
e Pameter | Last Receivd Value
OTT Compact Bubbler Sensor .
Water leval (CES) Waterlevel

Select the Type M2MCGI or M2MGGI depending on the use of CDMA-GSM or GSM-GSM
respectively for data transmission.
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Regional flood Information System - Data Management System (DMS)

Communication parameters for RTU-Kathmandu
Type: M2MCGI-11 =]
APN: WEB -
Communication parameters for RTU-Kathmandu
Username: WEB
Type: M2ZMCGI-11 =]
Password: WEB
Priority: Medium
Logging: Disabled AP WEB
Username: WEB
Password: WEB
Priority: High |Z|
Logging: Disabled |Z|
Save Cancel

Provide APN, Username and Password provided by the mobile service provider.
Priority: The modem having higher priority (High) will post data to server first. If the higher
priority modem could not send data, next priority (Medium) modem tries posting data.

Logging: If Enabled data logger logs modem status parameters like CSQ (signal strength),
modem error.

Iridium Tab

Iridium Modem can be operated in four different modes:

Disabled: Device does not use Iridium
to post data.

Regular Modem: Sets Iridium to post
regular data as general modems
(CDAM & GSM).

Special Log: Iridium posts minimum,
maximum and average of each
parameter once in a day

Alarm Only: Sends data whenever an
alarm condition is triggered

Communication parameters for RTU-Kathmandu

Type: M2MGGI-11 [=]
Made: Disabled |Z|
Save Cancel

Click “Save” to save these communication settings as configured.

Adding alert

Alerts can be incorporated into the system for parameters to generate alarm for any alarming

condition. For example: setting warning and danger levels for water level to generate alert for
flooding situation.

To setup alert, click “Add Alert” (2).

Add a alert in RTU-Kathmandu

e Select parameter for which alarm is to be

Parameter: Waterlevel |Z|
set.
Type: SMS E
Group: Bhutan Sl Select alert type :
Alstm on upper limit: | Enabled = o SMS: Alert is sent through SMS to all
Upper Threshold: the users defined in “Group”.
Upper Hysteresis: o Iridium: Alert is sent via Iridium to
Alarm on lower limit: | Enabled = server. To use iridium, iridium modem

Lower Threshold:

Lower Hysteresis:

9|Page
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Regional flood Information System - Data Management System (DMS)

5 Adding Users
W' Wscada Configuration
® B Projects Registered Users
2 (& Users
2 Nishant Agrawal acdlis
2 Sudat Tuladhar Eippiilirtion
2 Ranjan Shrestha nishant Mishant Agrawal 9802034152 nishant@rts.com.np Admin
- sudat Sudat Tuladhar 9841783167 sudat.tuladhar@rts.com.np  |Admin
eia Jayaram Dhakal - - : :
- ranjan Ranjan Shrestha 9802034150 ranjan@wscada.com Admin
eia Administrator jayaram Jayaram Dhakal 9541060149 jayaram@rts.com.np Admin
2 Sazzad admin Administrator 9999999999 admin@rts.com.np General
-~ Sandeep Paudel sazzad Sazzad 11892312 linfo@hmd.oov.bd General
» Mukunda Baidy sandeep Sandeep PaL.ldeI 981: Add a new User
- mukunda Mukunda Baidya 931,
& pema Pema pema 7 P General [=]
e (&g Groups \ Username: Sazia
&.RTS Narme: Sazia Khan
& Bhutan Mobile: 9801000021
Click on “Add User” to add a new user. Email sezia@yz.com
e Specify the type of user as General, N Adding a new user..
. ESCTIpTION:
Operator or Admin.
e Enter new user details and save it. =a W ooe
A newly entered user will be displayed in a
user description list
6 Adding Group
Click “Groups” on the left panel.
Click "Add Group”.
Add a new Group of users
= Enter group name.
MName: Hycos Group L.
= Add description to the group
Add group description... . . .
- aresp ° = Select users to be included in this
Description:
group.
» H an, "
¥ Mishant Agrawal [ sudat Tuladhar i Click “Save” button.
U Ranjan Shrestha Ja}-‘aram Dhakal |E When a group is SUCCQSSfU”y added it
sers: . . . .
[ Administrator ¥ sazzad — will be listed in a Registered Group.
¥ Sandeep Paudel [[Mukunda Baidya hd
Save Cancel

must be enabled in “Communication”

as described in section 3.

e Select Group to whom SMS is to be sent (if SMS is selected as Type).
e If alarm is to be enabled for upper limit of selected parameter, enable it and provide

upper threshold and upper hysteresis.

e Similarly, If alarm is to be enabled for lower limit of selected parameter, enable it and

provide lower threshold and lower hysteresis.

Remember!

Above settings (sensor parameters, communication, alerts) are not yet synchronized with the

device rather these are just saved into the database,

Press “Download” (3) button to synchronize these settings to device. When device establishes

a communication with the server, these setting are then saved into the device.
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Regional flood Information System - Data Management System (DMS)

C Data Management System

Data Management System (DMS) is a web based application that provides a Graphical User Interface (GUI)
to manage stations, field devices, quality control rules, aggregation rules, metadata and data.

1 Login
Log in to DMS with the provided link.

Data Management System : Login Panel

/ 1 Username admin@rts.com.np
= > Password seuasaves

e
> (o)

I/

AR\

Once authenticated, you are directed to following page.

* Data Management System

Wscoda Ver 20

Home Configuration Data Sync

® L Projects Configuration > Projects
& Networks ‘ i i
© Add Project | 3 Delete Project | (& Reload Configuration Data
83 Groups L |

® &3 Data Sources Project Name Short Name Start Date
® B Parameters

[F] Hydrological Cycle Observing System  Hycos
® & Stations

mU:—ers

(2] Mailing List

2 Creating Projects, Stations, Networks and Groups

2.1 Adding Project

Click * Projects or navigate to Configuration >> Projects

* Data Management System

Wicada Ver 20

- Configuration Data Sync

Projects Configuration > Projects
& Networks —_—
'@ Add Project h Delete Project| c Reload Configuration Data
-Grcups
& Data Sources Project Name Short Name Start Date

B parameters
#: Stations
mUEEI'E

[ Mailing List

[T Hydrological Cycle Observing System  Hycos
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Regional flood Information System - Data Management System (DMS)

&% Data Management System Click “Add Project”

Home Configuration Data Sync Project Name: Enter your

® L Projects Caonfiguration > Projects .
project name.

"‘ Metworks
i= List Projecls| c Reload Configuration Data

.Groups
@ {2 Data Sources __Add Project Short Name: Enter a short
® P t P
Jf arameters Project Name* Hydrological Cycle Observation System name or abbreviation of your
+ & Stations .
roject.
Blusers Short Name Hycos proj
M Mailing List -
start Date ansorz Start and End Date: Enter the
End Date start and end date of your
Enter project description.... prOjeCt.

Project Description
Project Description: Enter

description of the project.

. Save Project
Next, click on button to save.

Note: Only the fields marked “*” are mandatory.

2.2 Adding Network

1. Clickon - Metworks o navigate through Configuration >> Networks.
2. Click “Add Network".

=% Data Management System

& Projects Configuration > Networks
— et
@ Add Network J' 3¢ Delete Network | & Reload Configuration Data
.Groups e —— —_—
® 3 Data Sources Metwork Mame e Moot
® Biparameters h:-Add Metwork
® % stations
fusers MNetwork Mame* Nepal
Flnaiting List Network Code* NP-NT-01
Enter Metwork Description......
Metwork Description
‘t Save Metwork
Network Name: Provide name to the network you want to create.

Network name can be anything. It is just a way of classification of
station. For example, you can classify your network on the basis of
station type like Hydrological, Meteorological, Agro Met, etc.
Network name must be unique.

Network Code: Network code must be unique and it can have alpha numeric
characters.

Network Description: Provides a brief description of the network.

Click “Save Network" to save and create the network.
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2.3 Adding Groups

1. Clickon EGroups o navigate to Configuration >> Groups

2. Clickon & Add Group § enter the given fields.

* Data Management System

Wicodg Ver2.0

® | Projects

‘{' Metworks

® ;,J-Data Sources
® JﬂParameters
® & stations

mUsers

[ Mailing List

Group Name:

Group Code:
Group Description:

Click "Save Group”

Configuration > Groups

6—Add Group § 3 Delete Group c Reload Configuration Data
e~ i

Group Name Code Description

Configuration > Groups

i— List Groups| c Reload Configuration Data

E3Add Group
Group Mame* Low Land
Group Code* GP-LL

Enter the description......

Group Description

i Save Group

Group name can be anything it's another way if classification of
station. So, you can classify your group on the basis station
attributes of common or physical location or basins (like high
land, low land, SYNOP, etc.) whatever suits your requirement.
Group name must be unique. For hydrological station you can
create groups according to basin, for meteorological station you
can create group according to altitude.

Group code must be unique and can contain alpha numeric
characters.

Briefly describe group name though it's not mandatory but
recommended.

To view your saved groups click on Groups link in a tree view.

Heme Configuration Data

@ . Projects =

Configuration > Groups

B Metworks
= - Groups

@ Add Group | (& Reload Configuration Data

Low Land
High Land
& wWrao
a#GTS
& Mid Land
& 3 Data Sources

® B Parameters

& & Swations I

Group
Mame

Code Descript
Low Land GP-LL

High Land GP-HL

WhiO GR-WHKO

GTs GP-GTS

ki Land GP-hL
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2.4 Adding Parameter Template

Click # B parameters or navigate to Configuration >> Parameters. A list of pre-defined

parameters will be listed on a right pane.

Click “Add Parameter” to add a new parameter.

=% Data Management System

Wscoda Ver 2.0

® L|Projects Configuration > Parameters

“"‘ Metworks

.Groups

@’Add Parameter [ 3¢ Delete Parameter c Reload Configuration Data
— —_—

® {3 Data Sources Parameter Name

Short Mame Code Unit

® B parameters

@ & stations
mUsers

[ Mailing List

[C] Water Group
[ Waterlevel

[T Rainfall Group

Parameter Name: Parameter name

must be unique.

Parameter Short Name: Enter parameter
short name (not mandatory).

Parameter Description: Briefly describe
parameter. You can leave it blank but
recommended.

Parameter Code: Parameter code must
be unique and can contain alpha numeric
characters.

Parameter Interval: Defines units
(minutes, hours, days, months, years) in

which values are to be displayed in web.

the
current

Parent Parameter:
parameter

parameter is derived.

Specifies

from which the

Configuration = Parameters

i= List Farametersl  Reload Configuration Data

&4 Add Parameter

Parameter Mame* Relative Humidity

short Name HG_RH

briefly describe parameter......

Parameter Description

Parameter Code* 8

Parameter Interval* Minutes lz‘
Parent Parameter --SELECT-- |Z| ﬂ
Parameter Unit RH

Is Parameter Group Mo |Z|

If set to yes this parameter will not be treated as actual
parameter,it will be used to group other real parameters

‘t Save Parameter

Parameter Unit: Indicates unit of measurement for the parameter.

Is Parameter Group: If Yes is selected, it will
not be treated as the actual parameter, rather
as a group with set of real parameters.

“Water
Group” is not an actual parameter, it is used to

In the figure alongside, parameter

group other real parameter like Waterlevel,
Daily Water Level - Minimum, Daily Waterlevel -
Maximum.

Click “Save Parameter".

2 B Parameters
= B water Group
2 @ waterlevel-2

P Daily Water Level - Minimum-3
P Daily Water Level - Maximum-4

B rainfall Group

B Humidity Group

B \vind Speed Group
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To View saved parameter click on list parameter or click on parameter.

iData Management vystem
& Wae:

ada Ver 2.0

Home Configuration Data Sy

nc

® _Projects

Configuration > Parameters

’;l’ Metwarks

.Groups

@ Add Parameter | 3 Delete Parameter | c Reload Configuration Data

& (2 Data Sources Parameter Name Short Mame Code Unit Interval
[C] Water Group WG seconds
@ Bwater Group
[[] Waterlevel WG_WL 2 m minutes
&= .Rainfall Group
= @ Humidity Group [T Rainfall Group #RG# seconds
[ Rainfall RG_RF 1 mm minutes
@ @wind Speed Group o i
] Precipitation RG_PC 21 mm minutes
@ @ wind Direction Group
@ Bpressure Group [ Rain Intensity RG_RM_INT 111 mm minutes
@ @ Temperature Group [E] Rain Quantity RG_RMN_QMNT 113 mm minutes
@ C ication G
8 Communication Group [ Rain Quantity RT-NRT RG_RN_QNT_RT_NRT 112 mm minutes
@ .Voltage Group
@ B status Group [ Rain Quantity Total NRT RG_RMN_QNT_TTL_MRT 114 mm minutes
& BError Group [ Bucket Content NRT RG_BKT_COMT_MNRT 116 mm minutes
© @ Ssolar Radiation Group | = g, eyt Content RT RG_BKT_CONTRT 115 mm minutes
@ B oew Point Group
idi FHGE
® & stations [E] Humidity Group HG seconds
mUsers [ Relative Humidity HG_RH 8 %RH minutes
[Fhaiting List [C] Wind Speed Group FWSGE seconds

2.5 Adding Station

e Click
e Click “Add Station”

& Stations

iData Management 1— Vystem

ada Ver 2.0

Home @nfiguration ata Sync

® _|Projects
_E"_Networks
.Groups

® dData Sources

@ Ep ters
& Stations
mUsers

[] mailing List

Configuration > Projects >

C Reload Configuration Data

iData Management vystem
< WE

gdg Wer 2.0

on left panel or navigate through Configuration >> Stations.

Home Configuration Data Sync

® _|Projects Configuration > Stations

"‘J Metworks
- @ Add Station Delete Station | c Reload Configuration Data
Groups

® (& Data sources Station Mame

Code

® nParameters

[C] ® Hongtsho
® % stations

mUsers |:| ™ Sumpa
[T Mailing List
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Configuration > Stations

Station Name: Enter station name, it must »
:— List Station ‘ C Reload Configuration Data

be unique.
¥ Add Station
Station Code: It must be unique and can o=
ation : ) "
contain alpha numeric characters. Names  |Cunitsawa Code
Installation
. . 2012-04-26 Status
Installation Date: Date when station was  Date u
setup. Active 7R sy
Date 2013-06-23 Visibility

Status: Current status of the station. If it's in
operation select “Active” else “Inactive”.

Latitude Deg: 27 Min: 36 Sec: 36 Longitude

E‘r:::ed”e 2800 Timezone
Active Date: If Status is “Active”, provide _
date from when it came into operation. If  Type Automatic =] :;:a:u”ng
“Inactive”, provide date from which station ) i i

Project* Hydrological Cycle Observi E

became inactive.
» Hydrological
Visibility: Indicates whether station is to be

made visible publicly or limited to certain

groups.

Latitude/Longitude/Altitude: Provide stations latitude, longitude and altitude.

P Others

Time Zone: Time zone should be same as it is in the field device installed in the station.

Type: Select station type - Automatic, Manned, Automatic + Manned.

2806

Active

Public

Deg: 87 Min: 54

Bhutan - Asia/Thimpu

Hydrological

Measuring Type: This means type of data this station will provide. If it measures “Water level” measuring

type will be “Hydrological”. If it measures weather parameters measuring type will be “Climatology” and so

on.

. . V Others
Project: Select Project Name.
Contact Person

Other meta data of the station viz. contact
Contact Person Number

person, number, address, accessibility and —p>

landmark can be entered under Others s
Address

If Hydrological is selected for Measuring Aecesibiey

Type then provide the following

additional information.

|

Landmark

!, Save Station

¥ Hydrological
Basin Name
Catchment area (meter)

River name
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If saving is successful, you will be redirected to an interface as shown below where further information for
station can be provided.

| 4] AddSlaliDrlH = List Station ||5; List Gunitsawa pammehm” & Reload Configuration Ihla‘
#: Edit station Gunitsawa © Add on Guritsava | % Delete | € Retoad
tation — Cod Start Date z
iamef: Gunitszws Code* 5306 - % Add network for Gunitsawa
Instalsion oo ] 5 Select Network® [+]
2012-04-26 Status Active =]
Bt —_— Station Metwork Code™
E 2012-04-26 Visibility Pubiic =1
S I o Begin Date
Latitude Deg: 27  Min:| 36  Secc| 360 Longitude Deg: Min: Seco
End Date
tuds 2800m Timezone | Bhutan - Asia/Thimpu El
(mete Inherit QC Rule* YES =]
Type Automatic =] E‘:‘"i"g Hydrological =]
N —— p | s ave =]
Project Hydralogical Cycle Observw | s
|° Add Group on Gunitsawa || X Delete Group " c Reload Gluup|
P Hydroiogicsl
|Group Code Start Diate .‘“‘H group for Gunitsawa

P Others
Select Group* =]
& save Station R
Station Group Code®
Begin Date

End Date
Inhertt QC Rule® VES =]
Status® Active =]
L) F—— ' Fseve Group
°Station Detail °Add Network for Station. ° Add Group for Station.
2.5.1 Defining Station Network
4 Add network for Hongtsho Select Network: Select Network

name from a list.
Select Network®

Provide Network Code: Add code
which must be unique and can
Begin Date contain alpha numeric characters.

Station Network Code*

End Date Begin/End Date: Enter network

begin and end date. These fields
are not mandatory, you can leave
it blank.

Inherit QC Rule*

Inherit QC Rule: Select “YES" or
“NQO" for QC rule.

Status: Current status of a
network. If it's in operation, select

“Active” else “Inactive”.

.
Click to save.
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2.5.2 Defining Station Group
Provide group for the station that you are currently working. Station can belong
to multiple groups.

Select Groups: Select station group from
the list.

Station Group Code: Provide station
group code. It must be unique and can
have alpha numeric characters.

E8Add group for Hongtshe
Select Group™ El

Station Group Code” Begin/End Date: Add begin and end date

. for group. These fields are not mandatory.

End Date Inherit QC Rules: Indicates whether to
e ves inherit rules defined for selected group to
station under consideration.

Status*
Status: Select group status, if the group is

in operation select “Active” else “Inactive”.

Save Group
Click to save these settings.

2.5.3 Viewing Station
To view saved station, click on station name from hierarchical arrangement on the left
panel.

HData Management Eystem

cada Ver 2.0

Home Configuration Data Sync

© | Projects Configuration > Stations
W% Hydrological Cycle Observing System
v ¢ v e @ Add Station | i= List StalTons| € Reload Configuration Dala|
_Q Metworks
Bcroups, Click to view list of {lStation Information J%Run Rule Manually
@ (3 Data S0 StartDate 2013-06-23 00:00 EndDate 2013-06-23 23:59
@® Biparameters 5] EdT‘t| i= Paramelers| i= Sensors| i= Logs‘
. B - B o StationDevice RTDL-11(8206) lz‘ StationParameter ALL E‘
=] E List Aggregatlon| Q I}evlces‘ Q Commumcatlon|
-.?HongtshoBzol MName @ Gunitsawa
+® sumpa-5203
® Korila.a102 Active since 2012-04-26 LiSensors
«® Korilla
® Uzorong-5204 Installation Date 2012-04-26 P Undefined Sensor Parameter
@ «®Trashiyangtse-5205 Code 8206
@ ® Gunitsawa-3206 Station Type Automatic
Musers Measurement Type Hydrolagical
I Mailing List
M N Basin Mame
River Name
Catchment Area
Timezone Asia/Thimphu
Latitude 27-36-3.60
Longitude
Altitude 2800m
Project Hydrological Cycle Observing System
Visibility Public
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3 Adding Sensor

To add sensor, select Station on which you want to add sensor and then click on

=— Sensors

E]

7
&% Data Management System
£ Wicada Ver20
Home Configuration Data Sync
S lProjects Configuration > Stations
&Y Hydrological Cycle Ob Syst
— yerelogleal bydle Hhserving System Q Add Stalion| i= List Statinns| C Reload Configuration Data \
4 Networks #
.Grnups __|Station Information {¥Run Rule Man
¢ .‘.,jData Sources StartDate
® 8 parameters 4 Edil| &= Paramet s| i= Sensors | & logs|
= % stations ‘L l\stﬁggregalimn‘ Q Devices 'O_itnmmunicalmn| stationDevice
>
© Hongtsho-8201 Name @ Gunitsawa
P sumps3203 Active si 2012-04-26
£ _04- :
w|‘|(0r|||a.8202 CTIVE SINCE ;,.Sensors
w‘Uzorong-SZOet Installation Nate 2017-N4-76 B g
a dh n - Cod © Add Station!  Edit Station KSLCi-Patan Baitadi| @ Add Parameter | ¢ Reload Configuration Data
® o |
4 Gunitsawa-8206 Stati @ Add Sensor] ® Delete Sensor‘ c Reload Sensors| L4Add Station Sensor
e mUsers
M
B Undefined “@Sensor Name Sn. Sensor Name*
Basi
® 2t Administrator w SN
Ve
e H Mailing List
§Bundefined Cat Installation Date
e ™
Purchase Date
Manufacturing Company
Sensor Name: Speofy the Displavs list of Next Calibration Date
sensor being used. piay
added sensors Connected Device --SELECT--
SN: Field to enter Serial Protocol --SELECT--
Number of the sensor. Interface ~-SELECT--
Select Calibration Alert Group
Installation Date: Indicates USER GROUP MAILING LIST
date of installation. )
Alert Before Days 5
Purchase Date: Indicates date
of purchase of sensor. R
Manufacturing Company:
Indicates manufacturer of the |« I ’

sensor.

Next Calibration Date:

Indicates the date when the sensor is to be calibrated. Notification is sent through

email to various groups before the date set as Alert Before Days.

Connected Device:

manufacturer.

Protocol:

Interface:

Indicates device to which sensor is connected e.g. data logger from specific

Communication protocol between sensor and device (data logger).

Indicates the type of interface sensor uses to communicate with the data logger.
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Adding device
) i ) © Devices
To add device, select Station and then click on .

*Data Management System

Home Configuration Data Sync

2 lProjects Configuration > Stations

& Hydrological Cycle Observing System

°;: Metworks

@ Add Stati0n| i— List Stations| C Reload Configuration Data| \
{*Run Rule Man!

B Groups __Station Information
@ I Data Sources StartDate
& Edit | |8
® Bperameters - : — StationDevice
= % stations 'E‘ List Aggregation{]| @ Devices Communication|
—
=® Hongtsho-3201 Na —
‘I’Sumpa<€203 @ Add Station | o Edit Station Gunilsawa| @ Add Parameler| c Reload Configuration Data
Ac
=® Korilla-5202
' @ Add Device | 3 Delete Device | C Reload Device| [@lAdd Device
> Ins
=* Uzorong-53204
& = Trashiy 205 Ca Name Code Device Name*  RTDL-11
#=® Gunitsawa-5206 Stz
Device Code* 8206
8 mUsers
1t Undefined SN 1-201103-34
® (12 Administrator Lists added devices Device DataL.
i ata Logger
& ["1mailing List Category 99
8 undefined Eﬂanufacturing
— a PUpaS——— P 3 ompany
Purchase Date
Installation
Date
Description

Device Name: Specify the name
given to the device.

Device Code: Must be unique

for each device and can contain

alpha numeric characters.

SN: Specifies the serial number of the device.

Device Category: Specifies the type of device.

Note: For “Device Category” as “Data logger”, Device Code must exist in order to map the station with
data being sent by the data logger and must match with the one set to data logger.

Manufacturing Company: Specifies the manufacturer of the device.
Purchase Date: Indicates the purchase date of installation of the device.
Description: Field to enter description related to the device.

Adding Communication
Communication here indicates means by which data logger transmits data to central server that can
be through modem, manual SMS, manual form, etc.

1. Select Station to add communication parameters.
2. Click Communication.
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%
= Data Management System (

Home Configuration Data Sync

& IProjects Configuration > Stations

% Hydrological Cycle Observing System i . _ - -
@ Add Station | i= List 5tat|ons| c Reload Configuration Data|

“i" Metworks

B croups __Station Information {¥Run Rule Man
@ {3 Data Sources | | ° StartDate
& Edit|| = Parameters || £= Sensors| | i= Logs
® ﬂParametErs StationDevice
= % stations '}: listAggregation| Q Devicesﬁ(ommunication %,
“® Hongtsho 8201 Mame @ Gunitsawa 5
= sumpa-5203
=* Korilla-3202 A @ Add Station | 4 Edit Station Gunitsawa | @ Add Parameler| C Reload Configuration Data |
In
© Add | ¥ Delete | c Reload| ‘. Add Communication Means
Ci
5 == Type. sn. Protocal Provider Communication | Modem
M Modem Type GSM |Z|
Y
Data transfer protocal HTTP lz‘
sn
Purchase Date
Installation Date
Manufacturer Name
Sim Number
5im Activation Date
Communication: It indicates the type of means used by data logger to transmit data.
Different means of communication are:
i)  Modem
ii) Acquisition Script
iii) Manual SMS ‘2 Add Communication Means
iv) Manual Form Entry
Communication = Modem
i) If Modem is selected given interface is Modem Type GSM
displayed
L Data transfer protocal HTTP
Modem Type:  GSM, CDMA, Iridium.
Sn
Data Transfer Protocol: It indicates Purchase Date
the type of protocol used by the Installation Date

modem to communicate with the A e e

server.

Sim Number

E.g. GSM and CDMA use HTTP

- Sim Activation Date
whereas Iridium uses SBD.

Network Provider
Enter the SN, Purchase Date,
Installation Date, Manufacturer e
Name, Sim Number, Sim Activation
Date, Network Provider and

Remarks.

Click "Save”

21| Page



Regional flood Information System - Data Management System (DMS)

6

‘= Add Communication Means

ii) If “Acquisition Script” is selected,

you will have to provide the Source

Domain through which data is being

received.

Source Domain

Communication = Acquisition Script

Remarks
‘t Save
" Add Communication Means
Communication = Manual Sms
iii) If “Manual SMS" is selected,
then provide the Sender Name.
Sender Mame
Remarks
" Add Communication Means
iv) If “Manual Form Entry” is selected, Communication  Manual Form Entry

then provide “Feeder Name" who is
responsible for entering data to the

system.

Feeder Mame

Remarks

Adding Parameter

1. Select Station for which you want to add a parameter.

:— Parameters
2. Clickon

Home Configuration Data

iData Management System

Wseada Ver2.0

Sync

(i Projects

Configuration > Stations

& Networks

.Groups

© Add station | ;= List Stations | ¢ Reload Configuration Data

:2] dData Sources

® Birarameters

@ & stations
“® Hongtsho-8201
«® sumpa-8203

® Korilla-5202

__Station Information ° JXRun Rule Manually
StartDate 2013-
= B — Pai

rameters Sensurs : log§|

b ] ll;‘m Devices | @ Communication |

StationDevice RTDL-11(8206

Mame ||| @ Add Station| :» Edit Station Sirajganj| c Reload Configuration Data|
Active
Q@ Add Parameter| ® Delete Farameier| c Reload Parameters‘ .Add Station Parameter
Installa
Cod Parameter Name Code Unit Interval Parent B =
oo Parameter* SELECT
Station ] ® 4% | Rules| Waterlevel 2 m 15 minutes R —
! ! Parameter
Name* Short Mame
oe & | Rules Device Supply Voltage 14 *C 30 minutes
[ ® % | Rules| Additional Supply Voltage 2 *C 60 minutes | Description
] ® & | Rules|Modeml CSQ 1 30 minutes
Ezr;geter Type* Continuo
oe % | Rules| Modeml Recent Error 12 30 minutes
) Parameter Unit Visibility* Public
] @ | Rules|Modem2 CSQ I 30 minutes
Sensor
F] ® 4% | Rules| Madem2 Recent Error 74 30 minutes | Parameter --SELECT--
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Parent Parameter: Select  from  gadd station Parameter
the list of parameters. These are pre-

. . Parent 2 T.- [z' “‘
defined parameter list that were added  Parameter SELEC £
earlier in Section 2.4. Parameter

A Short Name
Selection of any parameter, auto fills
most of the fields.

e Descripti

Default values can be modified as per "
the requirement.

EZ::eter Type” Continuous [~]
Also, a new parameter can be created

Parameter Unit Visibility™ Public E]

instead of selecting from the list. You
can  toggle between selectin Sensor

&8 ) i & Parameter ~-SELECT-- E]
parameter from a list and creating a

' " Interval* Frequency* Minutes E'
J
. - Inherit QC
new one by clicking on button Py SesbE parshieter (Fe ) ;m:? Q VES =]
T Lower
Parameter Name: You can  Upperthreshold TR

change name of parameter but the
é' Save Parameter|

parameter name should not match
parent parameter name.

Parameter Code: Must be unique and can contain alpha numeric characters.

Type: Indicates type of data - Continuous or Accumulated.

Parameter Unit: Unit of measurement of the parameter.

Visibility: Indicates whether to make parameter visible publicly or to certain group.
Sensor Parameter: Select the sensor name providing this parameter. E.g. Water level is

given by Rader Level Sensor.
Interval & Frequency: Indicates interval of display of parameter.

Property: Indicates whether the parameter provides real time data or aggregated
data.

Inherit QC Rule: Indicates whether to inherit QC rule applied to that particular parameter.

Upper Threshold: Provides upper threshold for the parameter.

Lower Threshold: Provides upper threshold for the parameter.

Click “Save Parameter” to save above station parameter.

*Data Managem

7 User Management and Access Control
Users are grouped in category. A single user must have at least one category.

= LAPr Projects
W MNetworks
&y Groups

7.1 Adding User Group (User Category)

Data Sources

Click on B users in a tree view or navigate to Configurations >> Users. @

Parameters
B & )
Stations

|Users

Mailing List
® B parameters

Mailing List
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An interface with list of groups and user groups will be displayed.

Configuration > Users

C Reload User Data ] € Reload Configuration Data

@ Add Group @ Add User on group Administrator 10 Add User Group
Group Name  Group Email Username Name Organizal Group Name*
[F] Undefined [F]1 ® admin@rts.com.np Real Time Solutions
Group Email
[] Administrator
E qc Q Role Super Administrator E|
[C] pata Download
[F] Alert Group
e First Pane (1) lists all groups that were created.
e Second Pane (2) lists users in a particular group.
e Third Panel (3) displays form for adding a group and a user.
7.2 Adding Group
1. Toadd a new group click on & Add GroUp gisplaved in first panel.
2. Form for adding a new group will be in third panel.
|
3. Click to save.
7.3 Adding User to Groups
1. Select Group Name for which you want to add user.
2 Click on @ Add User on group QC
3. Fillthe form to add user in a group.
. Save User
4. Click to save.
Configuration > Users
¢ Reload User Dala| & Reload Configuration Da'a‘ °
@ Add Group @ Add User on group QC S2Add User
Group Name Group Email Name Organization FHinanes ] Organization
[ Undefined Country | city |
I Adminstator Designation Status Unblack =]
T
Landline no. Mobile no.

Contact
Address

Username Password

Select User Group

[C] administrator Qc
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8

Development of Quality Control Procedure

This section familiarizes with data quality control process and how to apply quality rules on data
from station. This section will enable one to design quality control to validate data from field devices
i.e., by applying rules. Rules can be simple mathematical operation and /or user defined function
based on time and data.

Note: Rules can be applied to individual parameter(s), network and groups.

There are 4 types of rules can be applied to each parameter - Limit Check, Step Check, Constant
Check, and Parameter Cross Check.

Data
Acquisition
Raw
Data Parameter Network Station
Rules Rules Rules
Invalid ) . )
Invalid Invalid Invalid
Flag Data,
Trigger <
Notification
Aggregate Store
Data < Processed
Data
8.1 Adding LIMIT CHECK to a parameter (Parameter Rule)
This rule checks if a parameter exceeds a certain 2 Nata M —
a anagemen stem
threshold limit = 9 e
Home Configuration Data Sync
. . . % : Projects o
Click on #Parameters from tree view or navigate to = freiss rojec Projects

& Networks Metworks

Configuration >> Parameters.

- Data Sources
= 3 Data Sources

I RTS DATA LOGGER Farameters
from the list of Parameters. camon | Stations

Click on parameter for which rule is to be applied

® 8 Parameter Users
i i= . oA :
Click on == Rules 6om parameter Information Uésm"ms
Llcor: I

1

Mailing List

Comply

8 croup: Groups !( Delete Project

Ele Observing Syst

p - - Configuration > Parameters
Configuration > Parameters
7| © Add Parameter| :— List Parameﬂters‘ C Reload Configuration Da‘ta|
@ Add Parameter‘ & Delete Parameter’ C Reload Configuration Data ‘
BiParameter Information
Parameter Name Short Name Code
[ Water Group HWGE Name Waterlevel | » Edig :— Rules ,
[ waterlevel WG_WL 2 Short name WG WL
—/ g Cod 2
[T Raiffall Group #RGE ode
= Interval minutes
"] Rairfall RG_RF 1
= Unit m
[T precipitation RG_PC 21
: Group @ [B water Group
[F] Rain Intensity RG_RN_INT 111
Is Group MNo
Description
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Let's take an example to define Limit check where
temperature must be between 5 to 30°C.

&4Add Parameter Rule
Title*

Select Rule

= LIMIT CHECK [=] Select Rule Type as “LIMIT CHECK".

et Jeperimt Provide Lower Limit and Upper Limit (must be

startate Ena pate numeric value): Check the lower and upper

Select Month Select All Dreselect All
thresholds for a parameter.
Jan Feb Mar Apr p
May Jun Jul Aug
sep oct Nov Dec Select Start and End date.
Severity MNOMNE El Execution Order 1] . .
Select Month: The applied rule will be executed
Rule on failure CONTINUEIZ‘ Alert Frequency (minutes.) 30 for Selected months Only For e g |f yOU SeleCtJan
Send alert Rule fail .
micrioe . | Y (=l Coeiyconmug NONE (=] and Feb, rules will be executed for these months
Select Alert
GFOUE < Only'

USER GROUP MAILING LIST
a2 BN e e Severity: If the value that DMS receives for this

parameter exceeds the limit than it will be flagged as the severity you select.
NONE: Indicates there is no error in value.

ERROR: Indicates value as Error and such value will not be visible in public domain.
SUSPICIOUS: Value is flagged as suspicious but is still visible in public domain.

Rules on Failure: Indicates what action is to be taken if data is not available for this rule to execute.
If “Continue” is selected, this rule will execute with severity as selected in “Rule failure severity
(Continue)”.
If “Halt" is selected, this rule will halt and further rule execution is seized.

Execution Order: Indicates priority of the rule execution if the parameter has more than one rule applied..
0 means higher priority, larger the numbers lower the priority.

Select Alert Group: Sends an alert through E-mail to selected group whenever the applied rule fails.
Provide the subject and message of the alert (email).

Pl el e o fff e Alert Frequency: Indicates time after which

USER GROUP MAILING LIST next alert is to be generated. It must be a
[C] Administrator [Tl others = numeric value.
[ qc i

Subject Click “Save Parameter Rule”.

Msg

The applied rule is displayed on left panel of
list of parameters.

!‘ Save Parameter Rule
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8.2 Adding STEP CHECK to a Parameter (Parameter Rule)

This rule verifies whether the rate of change of instantaneous value is within a limit or not.

Let's take an example where two consecutive temperature value differences cannot be
more than 0.3 °C

‘4 Add Parameter Rule

Title*

Select Rule Type | STEP CHECK

Check in (data

Allowed increment

Start Date

Select Month
¥ Jan
¥] May
V] sep

Severity

Rule on failure

Send alert on

15
B
value
the difference betweén two
10 consecutive value PONT B and
A POINT A is greater than 0.3 so
POINT B is an erroneous data
point
5
Time
Insert Title for the rule to be
applied.
5 Select Rule Type as “STEP
CHECK".
interval) 1 Hours . .
=] Increment: It indicates the
Include Suspicious YES IZJ maximum amount of
ABSOULTE(PREVIOUSDATA) - ABSOLUTE(RECEIVEDDATA) <= Allowed increment dev|at|on a”owed between
End Date two consecutive values. It
must be a numeric value.
Select All Deselect All
[¥] Feb ¥ m V] A -
et e e Include Suspicious:
¥ Jun V] Jul V| Aug
V] Oct ¥ Nov ¥ b “ p "
o 2 =5 Enter “Start Date” and “End
NONE [¥]  Execution Order 0 Date” for which the rule is
applicable.
CONTINUE [v]  AlertFrequency (minutes) 30
o Select Month: This rule will
VES E] Rule failure NONE B

rule failure

Select Alert
Group

Rule on Failure:
execute.

severity(CONTINUE)

be executed for selected
month only. E.g. If Jan and Feb
are selected, then the rules

will be applicable only for these two months.

It indicates action to be taken If no data is available for this rule to

If “Continue” is selected, this will execute with the severity as selected in “Rule failure
severity (Continue)”.
If “Halt” is selected, this rule will halt and further rule execution is seized.

Severity: Step Check checks if two consecutive values received for a parameter from a
station do not deviate much. To perform the step check the system requires two
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8.3

parameter values - values that we received (value that needs to be checked) and the
previous value (value that has already been checked and stored). If the difference between
these two values is greater than the increment you provided the value will be flagged as
the severity you select. Severity “NONE" denotes there is no error in the value. Severity

“ERROR" denotes error in the value and this value will not be visible in public domain. If
“SUSPICIOUS" is selected, this value is flagged as suspicious but will still be visible in public

domain.

Execution Order: Indicates priority of rule execution if more than one rule is applied to a

parameter. 0 means higher priority, larger the numbers lower the priority.

Select Alert Group: Generates an alert (email) whenever the rule applied to a parameter
fails. Provide subject and message to generate as alert.

Alert Frequency: Indicates time for generation of next alert. It must be a numeric value.

Click “Save Parameter Rule” to apply the set rule to the parameter.

Adding CONSTANT CHECK to a parameter
Let's take an example where temperature cannot be same for a period of time.

15 temperature is same
A fromAtoB B
value
g | I
5
Time
&4 Add Parameter Rule
Add Title for the rule.
Title*
Select Rule Type  CONSTANT CHECK [~] Select Rule Type as “CONSTANT
CHECK".
Check in (Data Interval) 1 Hours B
Min required Samples Tolerance Include Suspicious YES [EI Check in (Data Interval): Indicates
ABSOLUTE(MAX(data)) - ABSOLUTE(MIN(data)) >= Tolerance time duration of which data is to be
Start Date End Date constant checked.
- : For example: If 1 Hours is entered, QC
Select Month Select All Deselect All
@] Jan ¥ Feb @ Mar & Apr will apply rules to past 1 hour data for
V] May ¥ jun 1 Jul ¥l Aug constant check.
= ® @ Nov 7 . . .
B Jep o i i Min required Samples: Indicates
Severity NONE B Execution Order 0 reqUired number of Samples within
5 selected time interval in Check in
Rule on failure CONTINUE Alert Frequency (minutes.) 30
/ (Data Interval)
Send alert on : Rule failure .
it YES [~] severity(CONTINUE) NONE [=] Tolerance: Tolerance must be greater
Salact Alest than  the  difference  between
Group maximum value and minimum value
LISFR GROUP MATIING I1ST

amongst data selected within the
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selected time duration.

Include Suspicious: Indicates whether to include suspicious data among sample data to apply constant
check.

Other fields are similar to those rules described above.

Here, checks if the value being received for a parameter is changing. To perform the constant check, the
system requires value that we just received (that needs to be checked) and the precious values (values that
has already been check and stored), number of previous value required is determined by no. of samples.
The system will calculate the absolute mean from the no. of samples. If the difference between these two
values (calculated mean value and received value) is greater than the tolerance you provided the value will
be flagged as the severity you selected. If you select “NONE", it means there is no error in the value, if
“ERROR" it means error and this value will not be visible in public domain, if “SUSPICIOUS” this value is
flagged as suspicious but it's still visible in public domain.

‘tSave Group Rule

Now click . If saving is successful you will see the rule on left pane.
8.4 Applying rules to Networks and * Data Management E::ystem
< Wseads Ver 2.0
Groups
. Home -
As stated, rules can be applied to Bprojeds Projects =
networks and groups too. @ @ Networks Networks e
. = { Delete Group Reload 1
On the left panel, click Networks or @
Grou ps @ I3 Data Sources Data Sources Code
@ B Parameters Parameters
@ & stations Stations
mUsers Users
Fluaiing st Mailing List
e
A list of networks or groups is listed. Click on a network or group name to which rule is to
be applied.
) i— Rules )
Next, click on =— link (see an image below).
@ _|Projects Configuration > Groups
= _@_Netwurks
@ Add Group | X Delete Group | C Reload Configuration Data|
® B Groups
= G I . :
) & Data Sources i Bt Configuration > Groups
® Biparameters .
o _ Logland  GP-LL @ Add Group | = List Graups‘  Reload Configuration Data
I# & Stations
OH nd GP-HL
B users E3Group Information
[ Mailing List 1 wmo GP-WMO
Mame Low Land ||+ Edi
Code GP-LL
Description
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An interface is diplayed with list of applied rule on left (1) and a form to add rule on the right (2) with
“Add Network Rule” or “Add Group Rule”

Configuration > Groups > Low Land > Rules

Q Add Gmup| = List Gmup| ¢ Reload Configuration Data|

© Add Rule| X Delete Rule EAdd Group Rule
Title Rule Type Parar] Title®
TS;';: e LIMIT CHEC]|  Select Parameter Waterlevel =
Lower Limit Upper Limit
Start Date End Date
Select Month Select All Deselect All
lan Feb Mar Apr
May Jun Jul Aug
Sep Oct MNowv Dec
Severty NONE  [s]  Execution Order 0

Steps for applying different rules - LIMIT CHECK, STEP CHECK and CONSTANT CHECK have already
been described. Here, parameter for which rule is to be applied has to be selected under “Select
Parameter”.

Data Aggregation
To apply data aggregation on any data:

. . H Configuration Data S
Click on station on left panel for ignll s i By

. ® . Projects - £ i i
which the parameter needs to be Py ol Sonfiguration > Stations
& B4 Networks
aggregated. @ Nepal ’ © Add Station| :— List Stations’ € Reload Configuration Data ‘
Click “List Aggregation” © & Groups
geres : _ Station Information XRunt
@ Low Land T
s a au
® &3 Data Sources
Parameters| := Sensors|| := Logs
@® & Parameters I 4 4 StationD
© & stations 2 List Aggregation || §) Devices| @ Communication‘
Data  Aggregation form s ® ® Hongtsho 8201 | e S Bondiin
displayed on the right panel. 2 korif 5202 LaSensc
Active since
= sumila-8203 » OTTH
€3 Add Aggregation Rule <® Uzorong-8204 Installation Date 2012-05-20 » Unds
Title* . .
4 Title: Enter Title for the
Primary Input Aggregation - f
Param’zter‘(f“ -SELECT PARAMETE [+ TyE:Jge 9 Delayed Calculation [+] aggregated data, e.g. Discharge,
Dew Point.
Output
Parameter E]
Primary Input Parameter (X):
Status Enabled B Enable Alert YES (on failure) E] y . P ( )
Select primary parameter which
Alert frequency 20 .
{minutes) is to be aggregated to create
Select Alert Group derived parameter.
USER GROUP MAILING LIST
Administrator ) Others Aggregation Type: Offers
Qc different types of aggregation to
Data Download . yp gg g
Alert Group be applied to the parameter.
Subject Aggregation Type is broadly
‘o classified into Delayed

Calculation and Real Time
Calculation.

It will be discussed at the end of the topic.
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Output Parameter: Indicates the parameter formed after aggregation.

Status: Indicates whether to enable or disable the aggregation.

Enable Alerts: Indicates whether to enable alert if aggregation fails or generate alert on every
aggregation. Alert is sent to the selected group at certain interval defines at Alert Frequency
(minutes).

9.1 Aggregation Type:
Aggregation type can be broadly classified into:

i) Delayed Calculation: Applies aggregation to a set of data (data within an hour,
day, week, month or year) to create hourly, daily, weekly, monthly, or yearly value.

3 Add Aggregation Rule

Title*
Primary Input - e Aggregation = 5
Parameter(X} Relative Humidity B i Hourly E]
Incude Null | NO [x] include Suspicious YES (=]
Ao . \ Min. No. of required samples* (0
ag: function | | SUM B means ignore)
Time Offset*
{minute} . E =
Value Filter
Example

V=20 AND V<10
V==1 AND V<=10

(V=9 OR V=7}] AND V!=5

V IN (20,45,55)

OQutput . )

Daiainater Device Supply Voltage E]

New fields are generated if any of the Delayed Calculation Aggregation Type is
selected.

Include Null/Suspicious: Indicates whether to include null/suspicious values in
data aggregation.

Agg. Function: Indicates the type of aggregation (Sum, minimum, maximum,
average or count) to apply on data. Number of data for which aggregation is to
be applied is entered in Min. No. of required samples.

Time Offset: Includes data that lies within the time offset defined.

Value Filter: Indicates what data to filter so that no aggregation is applied on it.
Data is defined as a formula/rule.

ii) Real Time Calculation: Applies aggregation to real time data. This aggregation
can be applied to interpolate data.

§3 Add Aggregation Rule

Title*

Primary Input . i v Aggregation .

Parameter()} Relative Humidity B Type --Interpolation-Table B
@ Add ROV\A

g | o |
|
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10

Data Visualization

There are three types of data visualization available - Raw Data, Processed Date and Latest Data.

Raw Data: Displays all the data received from field device.

i Data Management System

Data > Raw Log

Timezone Bangaladesh - [v| Start-Date 2013-0522 |End-Date 20130522 Flag SHOW AL [v] Pagesize

Wseada Wer 2.0

Home Configuration - Sync

Displaying records 1-250 of 1089

DBooa

o Device

566597 8303 (Lalon Shah Bricge)
666598 8302 (Sirajganj)

655595 8303 (Lalon Shah Bridge)
66659 8302 (Siwajpany

656592 8303 (Lalon Shah Bridge)
665591

8303 (Ralon Shah Bricge)

Parameter

21 {Precipitation)
21 (Precipitation)
21 (Precipitation)
21 (Precipitation]
21 {Precipitation]

2 (Waterlevel}

Time zone: displays the country.
Start and End Date: indicates duration between which data is to be viewed.

Flag:

e Show All:

Displays all available data.

Time (Stotion timezone) Reoding

201305-22 11:25:00
2013.05-22 11:2500
2013-05-22 11:20:00
2013.05-22 11:2000
2013-05-22 11:15:00
2013.05-22 11:15:00

P w o o o6 o

E Hydrological Ty

Created

20130522 0!
201305.220!
201305-220!
201305-22 0%z
201305-2205:16:58
201305-2205:16:51

= Project

LULIAIILLVHLDDE
2013.05-22 05:18:52
2013-05-22 05:18:52

Raw Data
Processed Data
Latest Data

Feed/Edit Data [
Data Upload

KI> VAIA l\ﬂ:blk
RTS DATA LOGGER
RIS DATA LOGGER

¢ Not Found: Lists every data which are not mapped to the station (here mapping means in
terms of Device Code and Parameter Code).

e Paused:
e Retry:

Lists data that has been stopped for procession due to error in rule execution.
Lists all data points that has been processed more than 10 times.

e Processed: Displays all processed data that has been passed through QC rules.
e Unprocessed: Displays unprocessed data.

Processed Data: Displays all processed data that passed through QC rule.

Data » Processed Log

Timezone Gangaladesh - [=] Start-Date 2013-05-22  End-Date 2013.05-22  Severity SHOW aLL [~] PageSize 250 | View | Previous | Next | Download

Displaying records 1-250 of 526
i 3]

L Matian

L2 Sirajganj

619647 Sirajgan)

629645 Sirajganj

62644 Lalon Shah Bridge

62642

B29E43

Ladon Shah Bridge

Siraiaani

Poramater
Precipitation
Waterlevel
Precipitation
Precipitation
Precipitation

Precimitation

Time

20130522 05:4500

2013-05-2205:45400
201305-22 05:40:00
201 3-05-22 05:40:00
2013-05-22 05:35:00

012-05-22 05:35400

3@@@@@?

a

Sowree

RTS DATA LOGGER
RTS DATA LOGGER
RTS DATA LOGGER
RTS DATA LOGGER
RTS DATA LOGGER

FTS DATA LOGGER

Progeming Start

20130533 0%:50:%
01305-22 05505
2013405:22 05505
20130522 05465
20130522 054 28

20130527 054Nt

Severity: Allows selecting from the list to display only those data that has been flagged as OK,
SUSPICIOUS or ERROR.

Latest Data: Display recent data received in the server.

Data > Latest Received Data

Temezone EBangaladesh - Asia Thaka TI ".'Ir-w‘:
Saraggan Additienal Supply Veltage
Sirajgan; Modemnl 50

Sirasjgan; Modeml Recent Error
Saraggan Madem? C50)

Siraggan) Maodernd Recent Erer
Sirajgan; Modemd C50)

2013-05-22 05:00:00
2012-05-22 05:00:00
2013-05-22 05:00:00
2013-05-22 05:00:00
200 3-05-22 05:00:00

2003-05-22 05:00:00

1359

1%

13

< < < N < <

o

2013-05-22 050000 13.59
2013-05-22 050000 13
2013-05-22 05:00:00 13
2013-05-22 0500400 -«
2013-05-22 05:00:00 a
2013-05-22 05:00:00 Q
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Feed/Edit Data: Helps to manually feed and edit data.

Data > Feed/Correct Data > Hongtsho > Device Supply Voltage

Interval 30 MinuB Timezone Default - UTC E} Source ProceSS-B Start-Date 2013-11-15 00:00 End-Date 2013-11-15 23:59

Human Qc'ed Yes B Pass to System QC No B Devcie RTDL-11 E

Insert character 'N' to indicate N/A or invalid value

Observation Time Value Observation Time Value Observation Time Value Observation Time Ve

2013-11-1500:00:00 12.4676 (©] 2013-11-1500:30:00 124221 O 2013-11-1501:00:00 124221 @ 2013-11-1501:30:00 1
2013-11-1502:30:00 14.243 ©] 2013-11-1503:00:00 14,2886 @ 2013-11-1503:30:00 14.243 @ 2013-11-1504:00:00 1.
2013-11-1505:00:00 13,8561 @ 2013-11-15 05:30:00 2013-11-15 06:00:00 2013-11-15 06:30:00
2013-11-15 07:30:00 i 2013-11-15 08:00:00 i 2013-11-15 08:30:00 i 2013-11-15 09:00:00 i

Data Upload: Helps manually uploading data.

Data > Data Upload

@ Upload File| :— Upload List|

Select Template: You can select the
| template if it has been created

Aalmport Data

already. If “No”, create one by filling
the below fields.

Select
Template F8ELECT - [=] Select file type as Excel or Csv which
= — needs to be uploaded.
Csv Data start row: Indicates start row
number of the file which is to be
Description ) uploaded
- Exclude row: Indicates rows to be
Data start Row 1 excluded
Exclude Row Sheet number to process: Specifies
€g.10,20,40-70,75,85-95 total number of sheets in your file
Sheet number to process |1 which needs to be processed.
€g.1,2.4-5,10 Treat empty cell as null: Indicates
Tieat clpry cellas nol s [~] whether to treat empty cell in the file

Invalid values

as null or not.

# /An/aV=1A / NV . e
G395 $25 M tieey =1 AND V=0 NG T Invalid values: Specifies types of

Treat invalid value as null YES E} value to treat as invalid.

Select File No file chosen Treat invalid value as null

DataTimezone Default - UTC E] Indicates whether to treat invalid
2 i i value as null or not.

Select File: Browse for the file to be uploaded.

Data Timezone: Specifies timezone of data in the file.

Need to QC: Indicates whether to apply QC on data or not.

Human Processed: Indicates whether data of the file is human processed or not.

Data Source: Indicates source of data

Select Station: Indicates station of which the data is.

No. of columns: Indicates total number of columns in the file. According to the number of
columns entered, fields for column number and corresponding value are generated.

Click “Verify".

This entry is saved as a template. Next time, this template can be selected from “Select

Template”.
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D Content Management System (CMS)

Content Management System (CMS) is a web based application that provides a Graphical User Interface
(GUI). This section familiarizes with several server tools associated with content management system that
helps one to manage content for the website.

1 Login
Login into the CMS admin page with the link and credentials provided by RTS.

2 CMS Dashboard

The first page that you see after a successful login is a dashboard. Dashboard is an interface which
displays all the possible links needed for an effective website.

Web Content Editor Page

All Pages ‘fh’ Uzoreng Mews and Events Administrator 14:51, 2013-0ct-28 Mon
New Pages iy Sumpa News and Events Administrator 12:26, 2013-0ct-28 Mon
Recent Pages ﬁ’ Dorakha Mews and Events Administrator 14:16, 2013-0ct-28 Mon
Bookmarked Pages o Dorakha Hydrology Administrator 15:59, 2013-May-17 Fri
Unlinked Pages w Uzoreng Hydrology Administrator 15:56, 2013-May-17 Fri
» Resources & ot — p— )
Navigation otices Hydrology Administrator 15:51, 2013-May-17 Fri
w Tenders Meteorology Administrator 15:53, 2013-May-17 Fri

The right pane on the page list all the new pages created, booked marked pages, recent pages, etc.
The left pane displays the list of all the pages.

Web Content Editor Dashboard

All Pages Displays the list of all the pages. You can bookmark the page by clicking on

theﬁ icon.

New Pages Displays the list of all the newly created pages.

Recent Pages Displays the list of recently visited pages. It lists the details of who visited
the certain page and at what date and time.

Bookmarked Pages Displays the list of pages that were bookmarked in All Pages.

Unlinked Pages

Resources List outs all the files that were uploaded using the Image gallery or
Resources Panel. You can edit or delete any uploaded files form this
Resources page.

Navigation Navigation is a link using which you will create and design page.

34| Page




Regional flood Information System - Content Management System

3 Create New Page
To create a new page, click on Navigation link on the right pane.

\""[e 2 Web Content Editor

n Uzorong Hyarology
ves ke Sumpa Hydrology
Recent Pages ﬂ' Dorakha Hydrology
Bookmarked Pages w Dorakha Meteorology
Unlinked Pages w Uzorong Hydrology

» Resources w Motices Mews and Events
7 Tenders Mews and Events

Navigation link will display a list of all the navigations created previously.
To create a new page -

1. Click on the link where you want to create a new page. A tool box appears with an option to create
and edit page, delete, refresh and access control.

2. Click on Insert new navigation below tool to create a new link or click on Insert new child navigation

tool t te child igation.
Q0110 Create child navigation L'/(o{=l \Web Content Editor

All Pages 8 Home

Mevs Pages B About Us

Recent Pages [+ Meteorobgy

Bookmarked Pages B Hydrology

Unlinked Pages

» Resources a gﬂm and Events
igati [e T
Navigation | -
‘ e it 5 E E @ O

Tenders : 27
Motices : 28

‘ =
Insert new navigation below Insert new child navigation

Let's for instance, create a new child page with a name Career in News and Events. So, click on
News and Events and then click on Insert new child navigation button.

All Pages B Home
Mew Pages B about Us
Recent Pages B Meteorology
Bookmarked Pages o
Hydrof
Unlinked Pages ydrology
» Resources B Mews and Even

EEREODEEO
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A navigation dialog box appears where we are to provide the page information.

Title: Career
Banner: Choose File | Mo file chosen
State: [Tl Protected
V] visible
Link To: Mot linked to any page E

User Code: |Career

External URL:

(Prefix the url with '=' to open on a new window. Bx: =/?
q=2084. Link outside of icimod.org domain will always open
in a new window)

page to appear.

Banner: Choose a banner to
display.

State: Select the state which can
either be Protected or Visible or
both. Make sure to select the state
as visible else the navigation will
not be displayed.

Link To: Select a page from

dropdown menu if you want to link

to any specific page else select “Not
linked to any page".

User Code: Add user code.

External URL: Enter the external URL link if you want to redirect a link to any outside domain. The

link should be prefixed with “>" sign.

After you are done with adding information’s for the page, click on button.

Tools Description

Edit Tool: Clicking on this tool will enable you to edit page setting.

Insert new navigation below: Clicking on this tool will enable you to add new
navigation/page. The page created will be a main page.

Insert new child navigation: Clicking on this tool will enable you to add a child
page. The page created will be a child page of main page.

Remove navigation: Click to remove navigation.

select page content.

Edit Page: Clicking on this tool will redirect you to page where you can edit the

Refresh: Clicking on this will refresh the navigation page.

DE DD O e 8

Access Control: Using this tool you can set access permission for a page.
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Adding Page Content

To add content in a created page, follow All Pages B Home
the following steps: New Pages B About Us
. o . Recent Pages B Meteorolo
1. Click on Navigation link on the left gy
Bookmarked Pages B Hydrology
panel. Unlinked Pages
» ReSoUrces B Mews and Events

2. From the list of pages that appears click B News: 25
a page for which you want to add/edit its B Events: 26 .
content. Car

CEEOEED

3. From tools that appear, click on Edit

Page tool.

4. Clicking on the Edit Page tool will redirect you to Page Option where you can add your page
content.

5. Click on the page content area and add page content.

Web Content Editor
! © @ @ nsert | Sty Sze B I x* X = iE = = @ = e ¢ [ s
All Pages o
e I
New Pages AN (ol &3 R B R e 3"{.‘”
Recent Pages Department of Hydro-Met Services
Bookmarked Pages . Ministry of Fconomic Affairs
Unlinked Pages ational and water resources
» Resources g L 4 %w»‘”
Home AboutUs Meteorology Hydrology Early Warning News and Events Contact Us
News and Events Page Title
»
News Page Content
> Events Add your page content here...... .
Career Click and add page content
N, i

Note: Make sure to save and publish any changes that you have made in a page.

Page Formatting
You can add various components and formatting tools to your page content by using the tool bar at
the top.

Components Text Formattina Tools
1 ©® @@ msert Style Sze B X xT X IS OIS e= = 4 es ¢ T, I»
5.1 Components: Page Options *
T
 Page Properties® : With Page .. Administrator (2013-11-15 11:26:52)

Properties component add properties for
page.

Publisher: Administrator (2013-11-15 11:26:53)

Title: |Career |

Code: |ac|u:| page code._. |

add page tag{. -

. @ S Tags:
e Page Preview ™: Clicking on Page

Preview will provide an actual view of p

Module: [ Content [v]
Module Type: ﬂ

Status: Unlisted ] Protected

(San)
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how the page would look like be publishing.

Copy Components : This enables you to copy all the component of an existing page.

Paste Components : This enables you paste the copied components to a new page.

Insert Components Insert . you can add various components such as text, image, navigation,
etc., to a page. The various page components are described below -

a. Container: To add a new container for a page, click on Insert Component > Containers.

b. Text: To insert a new text area on a page, navigate to Insert Components > Text. This will
insert a text area on a page.

\'/[e(=8 Web Content Editor

|!°E%IInsert||Style Size B I X X, = iZ = = @4 @@ e ¢ T, I

Container

All Pages
New Pages
Recent Pages Image
Bookmarked Page HTML Panel

Unlinked Pages | external Links
» Resources

FISTES NN [FA YR AN G
Department of Hydro-Met Services
_ Ministry of Economic Affairs

s Navigation
Navigation
Tagged List <
Home AboutUs Meteorology Hydrology EarlyWarning News and Events
RSS Feeds
Resources Panel News and Events News Home Page
Home Panel 5
News Page Content Text area that you inserted
» Events . Content Here
.,

Note: Make sure to save and publish any changes that you have made in a page.

c. Image: To add image to a page, click on 1 © @ Bl nsert 4 e T
Image from the Insert Component tool.

Container
Text

Mew Pages

From the image gallery dialog box that Bookmarked Pagel HTML Panel

All Pages

appears, click on Choose File button and Uniinked Pages | eyternal Links

select the picture to add from your PC » Resources N
Mavigation Navigation

and close the box. Tagged List

Image Galery - RSS Feeds

Resources Panel

Home Panel

J ' The uploaded file will appear in

1456 x 1964 | 1669 x 2164 262 x 192 .
the Image Gallery and in a page.

Note: Make sure to save and
publish any changes that you have

Page i

Choose File | flo file chosen made in a page.
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HTML Panel: If you are to add any video
file on a page, use HTML Panel. Select the
area to insert HTML Panel and then click
on Insert Components > HTML Panel.

In the YouTube Browser dialog box that
appear, paste the embed code of a video
and click OK button.

YouTube Browser '

Paste the Embed code here:
me width="420" height="315"

Note: Make sure to save and publish any changes that you have made in a poge.

External Links: External Link enables you to link to any other external link. To add

external link to a page,

i. Click and select the area where you want to add the External link.

ii. Navigate to External Link from Insert Component tool. A link box will appear on a

page.

iii. Next, click on Text tool from the tool bar and set the title, description and style

for an external link box.

SXEmE NS = Box Title: Add box title
Box Title: |Lin|-cs |
Box Style: Select box style from
Box Style: |Defau|t El drop-down box.
Title: |Snme useful links |
Title: Add title for the links if any
else leave it blank
Description:
Description: Add description
o
for the links if any else leave it
’
blank.
Click OK.
iv. Click on Add Link tool from the tool bar that appears for External Links and
add link. o
Add a ink x
Text: |Link |

Link: |http-:.-*.-*mnn.rw»r.rts.u:u:um.r1p.-r |

e Text: Enter a

text that will
be displayed as a hyperlink.

e Link: Enter a link (URL) to which to redirect when it is clicked.

e C(Click OK button after you are - g e e e oo -

done.

The link that you just added will

appear in an External Link box.

e

Y
LINKS I Wy
! 3 Click to delate
External Link box

1
:
1

Mo = i ™ ™ ™ ™ i ™ ™ e ™ i ™ i ™ ™ ™ ™ ™ ™ i il

'
'
' ) 1 {
¥ Some useful links Y
]
]
]

- -
D

-

)
4

P
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E3
V. In order to delete any link, click on Remove Links from the External Link tool
bar.
vi. Select the link you want to delete and

click OK button.

vii. You also have an option to rearrange the link. To rearrange the link, click on the
link you want to rearrange and then click on Move Up or Move Down button to

.|
from the box  that

appears.
Text: Link 2

Link: |http://
|Mcwe Up | | Move Down | _______________

L}

| Some useful links i
[ Link .
+ ELink3 |
' [Dlink2 .
) 1

Note: Make sure to save and publish any changes that you have made in a page.

f. Navigation: Navigation enables you to place the navigation on any page position. By
default it is displayed on the left side of a page. To position the navigation on the right side
of a page, select the area to place it and then click on Navigation for Insert Components.
Save and publish the page.

Home AboutlUs Meteorology Hydrology Early Warming MHews and Evenis Contact Us

Mews and Events Events 0n|y - —
: : ews and Events
> News Fage Content nawgatlﬂn b New
Events placed on EWS
Tenders the right Events
Noti side of a Tenders
otices
page. Motices
Career
Career

g. Tagged List: Tagged list is for displaying pages that has been tagged same as in the
Tagged List. For example, let's create a section for display news.

i. Select the area to display Tagged List. Navigate to Insert Components > Tagged List.
Query: Add tag to display in
Title: Add title for Tagged List.

Description:  Add description for the tagged lists if any else leave it blank.
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Tagged List Properties *

Query: news

Empty List Replacement
Html: Add text to replace the
empty spaces if there is no
page to display matching
with the tag.

Title: Latest News

add descripticn...
Description:

Replace empty list...

Style: Select the ordering
style for the list of pages to | EmptyList Replacement Html:

display. _ 4
Style: Box |Z|

Class: Select the class (color) Class: None [=]

for the list of pages to | Lmit 5

display. Sort By: Default [~]
Sort Order: Ascending |Z|

Limit: Limit the number of = _. None  [=]

lists to display in a tagged list.

Filter Tolerance:

Sort By: Select the displaying
order of the list. You can display list either by title, publication date or by expiry date.

Sort Order: Select the sorting order of lists - ascending or descending.
Date Filter: Select how lists will be filtered.
Filter Tolerance: Limit the number of list to display.

h. RSS Feed: To add a RSS Feed on a page, click and select an area on a page to place an RSS
Feed box.

|'J{el=0 Web Content Editor
e Next click on RSS Feed from Insert Component

tool bar. ! © 8@ mer

e Click on Edit tool from the tool bar that appears

next to Insert.
e Setthe properties for RSS Feed in the RSS Feed Properties dialog box that appears.

RSS Feed Properties %

Title: RSS Feed

Title: Add title for the RSS Feed.

Description: Add description for

Rdd descripticn for feed... ) .
RSS Feed if any else leaves it

Description: blank.
A
: i ! .
Feed Url: http:/fuww feedurl com Feed URL: Add feed url to retrieve
Maximum Items: |4 a feed.
List Type: Box E

Maximum Items: Enter the
number of feeds to display at a

time.

List Type: Select list type to display RSS Feed. It can be either displayed in a box, numbered
list or in a bulleted list.

List Class: Indicates HTML CSS Class which would be used for styling the output for this
Feed Box

List Class:

Note: Make sure to save and publish any changes that you have made in a page.
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Resources Panel: You can use Resources panel to upload and share any information.

a) Select an area to insert Resources Panel on a page and then click on Insert

Component > Resources Panel.

Resources panel will appear on the selected place to insert it. Next, click on Text tool from
the tool bar that appears for Resources Panel and properties for resources panel.

Main Title: Add main title for
Resource panel. This will appear
as a panel name.

Box Style: Select box style to
display resources.

Title: Add title for the resources
if any else leave it blank.

Description: Add description for
the resources else leave it blank.

Download Resources... *®

Main Title: |Downloads
Box Style: | Default E
Title: Title

add descripticn if any...

Description

Click OK button to save the added properties.

b) Add resources to a panel by clicking on Add Items tool bar.

Add Resource

Resource:  |Early Warning System

File: EMS, 116 KB

Display Title: |Early Warning System

MNew -

E3
c) Similarly, clickon = (Removel
to remove and then click OK button.

Remove Resources x

o Resources: Enter resources
name.

File: upload a file to add in a
resources panel.

Display Title: Display title will
be same as resources. This
title will be displayed as a link
in a resources panel.

Click on OK button to save the
added resources.

Click on Save and then on
Publish icon.

Administrator -

tems) to remove any added resources. Select the file

—

[¥] Early Warning System (PDF, 116KB)

Note: Make sure to save and publish any changes that you have made in a page.
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5.2 Text Formatting Tools
The table below describes the various text formatting tools.

Tools | Description

Style | Add style to your headings.

Size | Add font size for page content.

B Bold tool enables you to give your text bold appearance.
I Italic tool enables you to give your text italic appearance.
e Superscript tool enables you to position your text slightly higher than the other

text on the line. Select the character to superscript and click on superscript tool.

X, Subscript tool enables you to position your text slightly lower than the other text
on the line. Select the character to subscript and click on subscript tool.

i= Numbered paragraph tool enables you to arrange information’s in list in numbers.

= Bulleted Paragraph tool enables you to arrange information’s in list in bullets.
= Indent tool enables you to add indentation to a paragraph.
= Outdent tool enables you to remove indentation from a paragraph.

= Insert Image tool enables you to insert image in a text box. Click on Insert Image

tool and select an image to insert or upload a new image.

e | Inserta ik ool enables you

to add link to any external URL
or internal pages. It also

Text: Type a text to hyperlink...

. @ Internal Page: |add internal page name to link
enables you to create email ]
3 @ External URL: |add a URL to link
address as a link.

) Email; add email address to link

Open link in new window

[=5] Remove link tool enables you to delete created link from a page. Select the link to
delete from dialog box and click OK button.

T Clear Formatting tool allows you to clear the formatting that you have applied to

L

any text. Select the text and the click on Clear Formatting tool.

Highlight Tool enables you to highlight the content in a text area.

',, Height Tool enables you to define the height of a text area. The height of a text
area is defined in pixels.
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6 Adding News and Events

Title ICIMOD connects the Himalayas to the Arctic

Home Page Title ICIMOD connects the Himalayas to the Arctic

Date 16 Mov 2013

Author type author name. ..

(Ex: John Doe)

External Link || |
(Ex: http-//newscenter |bl govifeature-stories/2010/02/03/black-carbon-himalayan-
glaciers/)

Content Content Here i |

Title: Enter the title of news.

Home Page Title: Enter the title of news to display in Home page.
External Link:  Enter the URL of news to display if it is from any other resource.

Content: Add content for news if there is no external link. The content field is same as the
Web content editor page that is for any normal page.

Save and publish the news thar |

is created by clicking on the All Pages o

icons at the top New Pages @ Avoutus
Recent Fages B Meteorology

Bookmarked Pages B Hydroogy

Unlinked Pages - "
placed first in News and Events | » Resources News and Events

The news that is created will be

it B News: 25
section and is not visible. Its
property needs to be changed to Testpage 54 Click on edit and set the
visible to display it on the site. Bxample : 53 properties to visible

RTS MEws : 74 E]' Ej D E-.:
e Arctic : 7

ICIMOD connects the Himalay 75
B Events: 26
Career : 60

as to th

Station Info Templates

Station Title: Enter the station title.

Station Info Template

Navigation Location: Select the navigation
location -  Hydrological ~ Network  or
Meteorological Network.

Station Title Uzorong

Mavigation Location | Hydrological Netwark

Station Code: Select station code from

Station Code Hongtsho
dropdown list.
Station Type Meterology
Station Type: Select station type - Hydrology
or Meteorology.
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Save and publish the
station that is created by
clicking on the icons at the
top.

The station that is created
be placed on the
station type that
selected and is invisible.
You will have to change its
properties to visible to
display it on the site.

will
was

7 Administration

7.1 Change Password

All Pages
Mew FPages
Recent Fages
Bookmarked Pages
Unlinked Pages

» Resources

& Home
B About Us
8 Meteorology
8 Hydrology
Flood Warning : 21
GLOF : 22
B Hydrological Metwork : 23
8104 : 37
Dorakha @ 42

Summpa : 45 Click on e_dit and_ set the
properties to visible

Uzoronn + 468

{EEEOEED

o

B News and Events

To change password for administration, click on Administration > Change password.

E] @ =] Page Options

Administrator

Enter old password, new password, confirm password in the Change Password dialog box

that appears and click on Change button.

Change Password...

Old Passwiord:
Mew Password:

Confirm Password:

x|

7.2 Sign out

To log off from the DHMS Web Content Editor, navigate to Administration > Sign out.
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Some useful SQL for easy data extraction directly from database

Station and parameter

"] station_audit v
] station_parameter_audit v _] station v id INT
id NT ] station_parameter v id INT » station_id INT
» station_parameter_id INT id INT » scope_id INT name VARCHAR(64)

name VARCHAR{64)
short_name VARCHAR(32)
description TINYTEXT

code VARCHAR(32)

interval DECIMAL{4,1)
interval_fraquency ENUM...)
unit VARCHAR(E)

——

» station_id INT
parameter_id INT
user_id INT
deleted_timestamp TIMESTAMP
>

sync_out_unigue_id VARCHAR(16)
deleted_timestamp TIMESTAMP
sync_change_detected INT
user_id INT
>
v

AFT UPDATE tgr_station_deleted_date

code VARCHARI(16)
installed_on DATE

latitude VARCHAR{24)
longitude VARCHAR{24)
altitude VARCHAR(18)
data_receive_blocking INT
address TINYTEXT

visibility BOOL F accessibility TINYTEXT
parameter type®OOL | L I landmark TINYTEXT
property BOOL } 10 Y —j<g > sensors_used TINYTEXT
inherit_ge_mile BOOL é station_type VARCHAR (64)
inherit_aggregation_definition BOOL n measuring_type VARCHAR(64)
data_receiva_blocking INT | parameter_audit v LullFstmter r limezone VARCHAR(32)
» user_id INT id INT o INT » project_id INT
timestamp TIMESTAMP » parameter_id INT ol scope.id INT status BOOL
~ parent parameter id INT I deleted_timestamp TIMESTAMP active, cate DATE
name VARCHAR(E4) i vser i3 INT inactive_date DATE
short_name VARCHAR(50) > visibility BOOL
description TINYTEXT ¢ timestamp TIMESTAMP
code VARCHAR(32) } » user id INT
parameter_interval ENUM(...) by L | >
unit VARCHAR(E) v
timestamp TIMESTAMP AFT INSERT tgr_station_audit_insert
» user_id INT

Station information is stored in two tables ‘station’ and ‘station_audit’.The main purpose of
creating two table is to record all the changes, there is no provision of update or deletion.Every time
user inserts the station information a new row is added in ‘station audit’ table preserving the
previous entry.While fetching the station information, latest record from the ‘station audit’ table
is supplied to the user.

Code :
SELECT s.*,sa.* FROM station as s
INNER JOIN (SELECT max (id) as max id,station id FROM station audit
group by station id)as saa ON (s.id=saa.station id)
INNER JOIN station audit as sa ON (saa.max id=sa.id)

(Note: same storing principle is followed for ‘parameter’ and ‘station_parameter’)
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Station network and group

" station_network_audit v ] station_group_audit v
id INT id INT
& station_network_id INT & station_group_id INT
newerk_station_code VARCHAR(32) ] station_network ¥ ] station_group hd group_station_code VARCHAR(32)
start_date DATE i INT id INT start_date DATE
end date DATE & station_id INT & station_id INT end date DATE
<tats BOOL Bl—0 3] @ network_id INT ¥ group_id INT H<s s'tat;s BOOL
inhert 6. ruls BOOL user_id INT ] station Y deleted_timestamp TIMESTAMP Inherit.ac. ruls BOOL
inherit_aggregation_definition BOOL deloted_limes amp TRMESTAMP it ) user_id INT inherit_aggregation_definition BOOL
) > @ scope_id INT » - -
. ::;’;:H‘::-TIMESTAMP ¥ ¥ syneoutunique 1a VARGHARAS) ¥ ¥ . :rsl':;:n‘lNTTIMESTAMP
I | deleted_timestamp TIMESTAMP | 1 P
. ?l EaSESas: + sync_change_detected INT === { =r[- .
® L _] network M user_id INT _] group v ] oroup_sua >
_ = id INT » id INT =
i INT @ scope_id INT ¥ & scope_id INT |INT
! mt;:;:;mm I L d“'““?.d—“mm”“’ TIMESTAMP AFT UPDATE tgr_station_deleted_date | deleted_timestamp TIMESTAMP | _1| Z:\r:;t:g]
| user_id INT user_id INT |
code VARCHAR(32) — ~ = L | description TINYTEXT
description TINYTEXT & group_id INT
@ user_id INT @ user_id INT
timestamp TIMESTAMP timestamp TIMESTAMP
»> »

Station network is stored in two tables ‘station network’ and station network audit’.The
main purpose of creating two table is to record all the changes, there is no provision of update or
deletion.Every time user inserts the station network information a new row is added in
‘station network audit’ table preserving the previous entry.While fetching the station
information, latest record from the *station network audit’ table is supplied to the user.
Code :
SELECT s.*,sa.* FROM station network as s
INNER JOIN (SELECT max (id) as max_id,station network id FROM
station network audit group by station network id)as saa ON
(s.id=saa.station network id)
INNER JOIN station network audit as sa ON (saa.max id=sa.id)

(Note: same storing principle is followed for ‘network’, ‘group’ and ‘station_group’)
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Station device, sensor and communication

Cid INT{11)
 sync_out_unigue_id VARCHAR(16)

“» sync_change_detected INT(1)

& station_id INT(11)

“» communication_means VARCHAR(64)
< modem_type ENUM|...)

< data_transfer_protocal ENUM(...)

Bl — — — — ! < acquisition_source_domain VARCHAR(1024)
<» modem_sn VARCHAR(128)

«» modem_purchase_date DATE

» modem_installation_date DATE

» sim_number VARCHAR(32)

¢ id INT(11) ¢ id INT{11)
“»sync_out_unigue_id VARCHAR(16) @ scope_id INT{11)
» sync_change_detected INT(1) 2 sync_out_unigue_id VARCHAR(18)

& station_id INT(11)  sync_change_detected INT(1)

 device_code VARCHAR(16) > deleted_timestamp TIMESTAMP

> name VARCHAR(128) & user_id INT(11)

 sn VARCHAR{128)

 device_type VARGHAR(84)

* installation_date DATE

> manufacturing_company VARCHAR(128) I

* purchase_date DATE I

> description VARGHAR(2048) L id INT(11) I
|
|

“» modem_manufacturer VARCHAR
& user_id INT{11) . sync_out_unigue_id VARCHAR(16) - 55)
“» sim_activation_date DATE
> deleted_timestamp TIMESTAMP & sync_change_detected NT(1) | | _ |
s L L VARCHAR(51
& station_id INT(11) sim_service_provider_name (512)

‘s remarks TEXT

“» sensor_name VARCHAR|255)
fffffff —i< > sn VARCHAR(128)

> manufacturing_company VARCHAR(255)
< purchase_date DATE

> installation_date DATE

- < remarks TEXT L id INT(11)
Cid INT(11)
. next_calibration_date DATE O syne. ique_id VARCHAR(16,
@ station_sensor_id INT{11) Syre-outumauet e
— S user_ _ids VARCHAR(1024) ] chan detected INT(1
* calibration_date DATE —H goup Syne-shangs s o
) > mailing_list_ids VARCHAR(1024) & station_id INT(11)
> calibration_test_certificate VARCHAR(128)
> alert_before_days INT(3) > category VARCHAR(255)
< station_device_id INT(11) ) start_date DATE
‘. data_transfer_protocal VARCHAR(64) 2 end_date DATE
< interface VARCHAR(64) ) description TEXT
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QC Rule
| wa_rule i | parameter i
id INT{11) id INT(11)

sync_out_unique_id VARCHAR(16] " i INT(11)

sync_out_unique_id VARCHAR({16)

%

sync_change_deteded INT(1)

» order INT(TT) j'c'- # sync_change_deteced INT(1) T -i
rule_of ENUM..) 1| deleted_timestamp TMESTAMP }%
2 station_parametar_id INT(11) o )
Juser_id INT(11] -
- statio I_parameler v
» parameter_id INT(11) > j

_ id INT(11)
network_id INT[11)

&

sync_out_unique_id VARCHAR{16]

&

group_id INT[11)

» sync_cha detedad INT([1}
rube_type EMUMI ...} ync_change_ (

%,

& station_id INT{11}
start_date DATE -

_______ O
| 2 parameiar_id INT(11}
end_date DATE |

s usar id INT[11]
parameter! VARCHAR{10) =TT ! - [

deleted_timestamp TIMESTAMP

parameier2 VARCHAR(10)

| 2
» severity INT{11)
| 4
user_group_ids VARCHAR(1024) _| metwork v
mailing_list_ids VARCHAR(1024) id INT[11}

subject VARCHAR(1024) & scope_id INT(11)

msg TEXT L | deleted_timestamp TMESTAMP
alert_fraquancy INT(11) > user id INT(11]
data_interval INT(11) .
data_interval_type VARCHAR(2S)
date_time_order VARCHAR(2S)
indude_suspicious VARCHAR(25) jﬂ:::: : v
ruke_on_failure VARCHAR(25) > soope._id INT(11)
manth_selact VARCHAR(13) S — — —" 7 "M deleted_timestamp TMESTAMP
title VARCHAR(255) s user id INT(H]
rule_failure_alert INT(1} .
rule_fzilure_severty INT(11)
sync INT(1)
deleted_timestamp DATETIME

[

All rules defined will be stored in table "wa_rule’.Following are the attributes and its use.

sync_out_unique_id : auto generated 16 character length unique id.Generated when rule is
created.This id will be used while synchronization of the rule in multiple domain.

1. sync_change_detected : set to 1 when user update the rule definition.So, that the system
knows to sync the changes to other domain if the rule has been synchronized.

2. order : rule execution order.

3. rule_of : to whom this rule belongs to (parameter,network,group,station parameter)
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4,

10
11

12.
13.

14

15.

16

17.
18.
19.
20.

station_parameter_id : this field is set to the corresponding station parameter if rule_of is
station_parameter otherwise this is set to NULL.
parameter_id : this field is set to the corresponding parameter(global parameter) if rule_of is
parameter otherwise this is set to NULL.
network_id : this field is set to the corresponding network if rule_of is network otherwise this is
set to NULL.
group_type : this field is set to the corresponding group if rule_of is group otherwise this is set
to NULL.
rule_type : type of rule (limit_check,step_check,constant_check)
start_date : rule execution begin date.
. end_date : rule expiry date.
. severity : 0 (ok),1 (error),2 (suspicious)
user_group_ids : comma separated user group ids
mailing_lis_ids : comma separated mailing_list ids
. subject : alert subject
msg : alert body
. alert frequency: numeric (minutes after which next alert will be send)
rule_on_failure : ‘halt’ or ‘continue’ .(In case rule fails to run)
rule_failure_severity : only applicable if rule_on_failure is continue.0,1 or 2.
rule_failure_alert : send alter if rule fails to run.
month_select:13 character long.Each character position reflects to the month and character
can only be 0 and 1, except first character.1st character will always be #.
example : #100100000000
2st position character is set to 1 means January
5th position character is set to 1 means April
this means rule is application to run only for January and april.

If rule_type is 'limit_check’

1
2.

3
4.
5

parameterl : upper limit

parameter2 : lower limit

include_suspicious : NOT SET/NOT REQUIRED
data_interval : NOT SET/NOT REQUIRED
data_interval_type: NOT SET/NOT REQUIRED

If rule_type is "step_check’

parameterl : Allowed increment.Numeric
parameter2 : NOT SET/NOT REQUIRED
include_suspicious : 1 for ‘yes’,0 for ‘no’
data_interval : Check in (data interval).Numeric.
data_interval_type: ‘hour’ or ‘minute’

If rule_type is “constant_check’

arwdE

parameterl : Min required samples
parameter2: tolerance

include_suspicious : 1 for ‘yes’,0 for ‘no’
data_interval : Check in (data interval).Numeric.
data_interval_type: ‘hour’ or ‘minute’
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Aggregation Rule

O O
| station ¥
station_parameter ¥
- id INT(11)
id INT(11)
& scope_id INT(11)
sync_out_unigue_id VARCHAR[16)
sync_out_unigue_id VARCHAR(16)
sync_change_detected INT(1) T T =
e e o o e o o e o 47~ sync_change_detected INT(1) 0
 station_id INT(11)
deleted_timestamp TIMESTAMP
parameter_id INT(11) —| wa_aggregation v
. user_id INT(11)
user_id INT(11) L id INT(11)
— ]
deleted_timestamp TIMESTAMP | title VARCHAR(255) .
> | station_id INT{11)
O O
> I & input_parameter_id INT{11) ?
:F I & output_parameter_id INT(11) |
| | aggregation_type VARCHAR(G64) I
| | include_null TINYINT(1) |
| |
|
| |_ —1g include_suspicious TINYINT(1) Ry LI TVTI T T T 1
|
| value_filter VARCHAR(1024)
wa_aggregation_queue ¥
| week_start_day INT(1) —] wa_sg L
| id BIGINT{20)
| table_values VARCHAR{1024)
@ wa_aggregation_id INT(11)
I time_offset VARCHAR(8)
| obs_time TIMESTAMP
min_samples INT(11)
| data_start_time TIMESTAMP
| aggregation_function VARCHAR|B4)
| data_end_time TIMESTAMP
| enable_alert INT{1)
created date TIMESTAMP
| status INT{1)
| transfer date TIMESTAMP
e == —< < user_greup_ids VARCHAR(1024) H—
processing_start_time TIMESTAMP
mailing_list_ids VARCHAR(1024)
processing_end_time TIMESTAMP
subject VARCHAR(2048)
retry_count INT(11)
msg TEXT
generation_source ENUM|...)
alert_freguency INT(11)
_type ENUM|...)
last_alert_time TIMESTAMP
value FLOAT
last generated time TIMESTAMP
remarks VARCHAR[1024)
deleted_timestamp DATETIME

Aggregation rules can be defined on station basis only and stored in table ‘wa_aggregation’.
Following are the attributes and its use.

1.
2.

e o o 0o o [

station_id : this field is set to the corresponding station.
input_parameter_id : this field is set to corresponding station parameter. This is the input
parameter for the aggregation rule.
output_parameter_id : this field is set to corresponding station parameter. This is the
parameter for which this aggregation rule will be executed using input parameter.
example:Input parameter : Rainfall

Output parameter: Daily Rainfall

aggregation_type : can be one of the following
hourly : delayed calculation

daily : delayed calculation

weekly : delayed calculation

monthly : delayed calculation

yearly : delayed calculation
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e table :Interpolation-Table, real time calculation
delayed calculation : aggregation rule will be executed after the specified time
real time calculation : aggregation rule will be executed as soon as the input parameter is
received.
status : 1 enable,0 disable
user_group_ids : comma separated user group ids
mailing_lis_ids : comma separated mailing_list ids
subject : alert subject
. msg : alert body
0. enable_alert : 1 yes,0 no (need to send alert when aggregation fails to execute)
1. alert frequency: numeric (minutes after which next alert will be send)

RB©o©o~No O

Fields applicable to delayed calculation only

e include_null: 1 yes,0 no
e include_suspicious : 1 yes,0 no
e value_filter : expression to rule to filter the input parameter values while calculation.
example : V>20 AND V<10
V>=1 AND V<=10
(V=9 OR V=7) AND VI=5
V IN (20,45,55)
where ‘V’ is the input value.
e aggregation_function : can be sum,min,max,avg,count.
e min_samples : minimum no. of required samples of input parameter
if 0 is supplied this field is ignored.The aggregation rule will use all the available samples for
calculation

If aggregation_type is ‘hourly’

e time_offset : minute offset to (+)add/(-)subtract to hour

example :
lets suppose the date is 2013-01-01 00:00:00
+12 is the offset then it will aggregate data from 2013-01-01 00:12 - 2013-01-01
1:11,2013-01-01 1:12 - 2013-01-01 2:12 and so on
-12 is the offset then it will aggregate data from 2012-12-31 23:48 - 2013-01-01
00:47,2013-01-01 00:48 - 2013-01-01 1:47 and so on

e table_value : NOT SET/NOT REQUIRED

o week_start_day: NOT SET/NOT REQUIRED

If aggregation_type is ‘daily’/’monthly’/’yearly’
o time_offset :hour: minute offset to (+)add/(-)subtract to hour

e table value : NOT SET/NOT REQUIRED
o week start_day: NOT SET/NOT REQUIRED

If aggregation_type is ‘weekly’
o time_offset :hour: minute offset to (+)add/(-)subtract to hour

e table value : NOT SET/NOT REQUIRED
o week start_day : range from 0-6(Sunday-Saturday

If aggregation_type is ‘table’
e time_offset NOT SET/NOT REQUIRED
e table value : comma separated key value pair (eg.10-20,20-30,30-40)
e week start day: NOT SET/NOT REQUIRED
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Data Storage

| raw_log_paused_executed_rule ¥
rule_type VARCHAR({128)
» raw_log_id BIGINT(20)
& wa_rule_id INT{11)
severity INT(11)
rule failure INT(1)
processing start time TIMESTAMP
processing end_time TIMESTAMP
status VARCHAR (50)
L4

Hi—|<

| raw_log v
| K BIGINT(20)
obs_time DATETIME
obs_value DOUBLE
» device_code VARCHAR(25)
parameter_code VARCHAR(25)
pass_qe INT[1)
pass_aggregation INT{1)
data_source_id INT{11) o
user_id INT(11)
transfar_date TIMESTAMP
s ereated_date TIMESTAMP
interval INT{11)
read_pir INT(11)
write_pir INT{11)
source_ip VARCHAR(16)
not_found INT{1)
paused INT(1)
v is_processed INT(1)
remarks VARCHAR(255)
retry_count INT{11)
procassing start_time TIMESTAMP

procassing end_tme TIMESTAMP
>

Table “raw_log"

e —

| wa_observation_audit v
id BIGINT (20)

& wa_observation_id BIGINT (20)

# raw_log_id BIGINT(20)

# slation_parameter_id INT{11)
abs_time TIMESTAMP
obs_value FLOAT

=< saverity INT(11) IH

| » data_source id INT{11)

l is_processed INT(1)

: user_id INT(11)

| » processing_start_time TIMESTAMP
: processing end_tme TIMESTAMP
l log_time TIMESTAMP
|

|

|

|

|

|

|

|

ri<

1
T

| wa_observation v
id BIGINT (20)

» raw_log_id BIGINT{ 20
# slation_parameter id INT(11)
» obs_time TIMESTAMP
obs value FLOAT
sevarity INT(11)
¥ data_source_id INT(11)
— is_processed INT(1)
: usar_id INT(11)
- processing start_time TIMESTAMP
» processing end_tima TIMESTAMP
transfer_to_avdit INT(1)
log_time TIMESTAMP
syne INT{11)

I'_____'|

| wa_observation_audit_rule_executed ¥
¥ wa_observation_audit_id BIGINT(20)
»wa_rule_id INT(11)

rule_type VARCHAR(128)
» saverity INT(11)

rule_failure INT{1)

processing start_time TIMESTAMP

processing end_time TIMESTAMP

status VARCHAR(50)

| wa_observation_rule_executed ¥
& wa_rdle_id INT(11)
» wa_observation_id BIGINT (20)
rule type VARCHAR(128)
» saverity INT(11)
rule failure INT(1)
processing start_time TIMESTAMP
processing end_time TIMESTAMP
status VARCHAR(50)

¥
I
|
|
|
|
|
|

Every point of data that needs to be processed should be in this table.This is the only table from
where DMS(QC) processes the data. Following are the attributes and its use
1. obs_time : data received time(station timezone not utc).
2. obs_value: observed value
3. device_code : device unique identifier from where the observation is sent.Alphanumeric
4. parameter_code: parameter unique identifier.Alphanumeric.This code recognize the observed
value to which parameter its belongs to.

ou

domain.

pass_dc : set to 1 if it needs to pass through qc, otherwise O.
data_source_id : respective data source (table data_source).This defines the data originated

7. user_id : if the data is inserted by any user set it to respective user id , otherwise NULL.
8. transfer_date : time when the data is transferred to processed log (table wa_observation).
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9

10.
11.
12.
13.

14,
15.

16.
17.
18.
19.

created_date : time at which the data point is stored in the table.

interval : applicable only when data send by ‘RTS data logger’.Parameter received interval.
read_ptr : applicable only when data send by ‘RTS data logger’

write_ptr: applicable only when data send by ‘RTS data logger’

source_ip : applicable only for data send by ‘RTS data logger’.IP address of the source at the
time data is received.

not_found : set to 1 if device_code and/or parameter_code mapping is not found,otherwise 0
paused : set to 1 if rule has not enough data to run the rule or rule execution is incomplete
,otherwise 0.In this case all the rules executed till the failure will be inserted in table
‘raw_log_paused_executed_rule’

is_processed : set to 1 if human intervention is applied process data, otherwise 0
retry_count :Number of times QC engine tries to process the data point.
processing_start_time : begin time of processing the data point

processing_end_time : end time of processing the data point

Table "wa_observation’

After processing data from "raw log’ data is then inserted into "wa_ observation’ table and the all
the rule executed for the data is inserted into table 'wa observation rule executed'.In case, if
data already exists for the station parameter for a specified time the system copies the previous data
to ‘'wa_observation audit’ and rules to ‘wa_observation_audit_rule_executed .Following are the
attributes and its use

oukhwnrE

© o N

10.
11.

12.
13.

id : auto increment number

raw_log_id : associated raw log id from table raw_log

obs_time : observation time in UTC.

obs_value : observation value

severity : data error category.Can be 0(ok,no error),1(error),2(suspicious).
data_source_id: respective data source (table data_source).This defines the data originated
domain.

is_processed:set to 1 if human intervention is applied process data, otherwise 0
processing_start_time : begin time of processing the data point

processing_end_time : end time of processing the data point (including all rules execution
time)

user_id : if the data is inserted by any user set it to respective user id , otherwise NULL.
transfer_to_audit : if set to 1 (on update previous data point is copied to
wa_observation_audit table)

log_time : time data inserted into wa_observation.

sync: if set to 1 data point is eligible to be synchronized otherwise not.
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User Management

_] user v _| user_user_group ¥ " user_group. v
id INT{11) user_id INT(11) id INT{11)
usemame VARCHAR(3Z) user_group_id INT(11) name VARCHAR|50)
password VARCHAR(512) > description TINYTEXT
blocked TINYINT(1) . group_email VARCHAR(150) -
forgot_token VARCHAR(50) role ENUM...)
forgot_timestamp TIMESTAMP deleted_timestamp TIMESTAMP
deleted_timestamp TIMESTAMP ] user_info d >
> id INT(11) O 0 O
Fuser_id INT(11) |
T full_name VARCHAR(128) |
I organization VARCHAR(1 28) #
I country VARCHAR(64) | user_group_privilege ¥
S EEBSEESE —< city VARCHAR(G4) » user_group_id INT(11)
designation VARCHAR(G4) @ station_id INT(11)
contact_address TINYTEXT privilege SET(r,'c",'d)
landine_no VARCHAR(32) >
mobile_no VARCHAR(32)

[

Each and every user should belong to minimum one user group.User privilege is inherited from user
group privilege.

Table “user”

e username : must be valid email address

e password : must be md5 hash

e Dblocked : if set to 1 user is not allowed to access DMS.

e forget_token : token to reset password

e forgot_timestamp : time when user request to reset password

table ‘user info’ contains general user details.
Table “user_group_privilege"

e user_group_id : corresponding user group

e station_id : corresponding station.

e privilege : can be r(read) and/or c(create) and/or d(delete). This privilege is
applied to the station selected.
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Alert (Email)

| email_queue 4
id BIGINT{20)

# email_gueue_msg_id BIGINT{20)
email_address VARCHAR|25)
created_date DATETIME

send_date DATETIME

| email_queue msg ¥
id BIGINT{20)
msg TEXT
subject VARCHAR(1024)
|

All emails generated by the system is stored in this table, these email will be processed by Alert

Engine on timely basis.

DB Views

1. vw_global_parameter

Lists all the parameters which has not been deleted.

2. vw_device_station

List all the station devices which has not been deleted

3. vw_mailing_list

List all the users on the mailing list

4. vw_observation

List processed data points with station name and parameter name

5. vw_raw_log

List raw data that has not been processed by QC with station and

parameter name
6. vw_station_group

List station along with group name.

7. vw_station_network

List station along with network name.

8. vw_station_parameter
List station parameter.
9. vw_user_group

List user along with user group.
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Stored Procedures

1. proc_update_latest_data
CREATE PROCEDURE "proc update latest data’ (IN deviceId INT,IN categoryId
INT, IN value DOUBLE, IN valueTime DATETIME)

MODIFIES SQL DATA
DETERMINISTIC

BEGIN
DECLARE prevTime DATETIME DEFAULT NULL;
DECLARE prevValue DOUBLE DEFAULT NULL;

DECLARE cur latest CURSOR FOR
SELECT “time’, 'value®' FROM ‘wscada_latest_data’ WHERE
wscada device id=deviceld AND wscada data category id=categoryId;
DECLARE CONTINUE HANDLER FOR NOT FOUND SET @no more rows = TRUE;
OPEN cur_ latest;
loop into:LOOP
FETCH cur latest INTO prevTime,prevValue;
IF @no more rows THEN
CLOSE cur_ latest;
LEAVE loop into;
END IF;

END LOOP loop into;

IF (prevTime IS NULL AND value IS NOT NULL) THEN
INSERT INTO
‘wscada latest data’ (wscada device id,wscada data category id,latest value,latest time)
VALUES (deviceld, category id,value,valueTime);
ELSEIF (prevTime IS NOT NULL) THEN
IF (prevTime<valueTime AND value IS NOT NULL) THEN
UPDATE “wscada latest data’ SET
"latest value '=value, "latest time =valueTime WHERE ‘wscada device id'=deviceId AND
‘wscada data category id'=categoryId;
END IF;
END IF;
END
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Triggers

SN | Trigger Event Defined on Table
1 tgr_station_deleted_date AFTER UPDATE | station

2 tgr_station_audit_insert AFTER INSERT | station_audit

3 tgr_station_parameter_deleted_date | AFTER UPDATE | station_parameter

4 tgr_station_parameter_audit_insert | AFTER INSERT | station_parameter_audit
5 tgr_wa_observation_insert AFTER INSERT | wa_observation
6 tgr_wa_observation_update AFTER UPDATE | wa_observation

tgr_station_deleted_date

BEGIN

IF NEW.deleted timestamp IS NOT NULL THEN

DELETE FROM station min WHERE station id=NEW.id;

END IF;

END

tgr_station_audit_insert

BEGIN
DECLARE sid INT DEFAULT NULL;

SELECT station id FROM “station min® WHERE station id=NEW.station id INTO sid;
IF(sid IS NULL) THEN

INSERT INTO station min
(station id,code,visibility,name,project id,station audit id) VALUES
(NEW.station id,NEW.code,NEW.visibility,NEW.name,NEW.project id,NEW.id);
ELSE

UPDATE station min SET code =
NEW.code, name=NEW.name, project id=NEW.project id,station audit id=NEW.id,visibili
ty=NEW.visibility WHERE station id=sid;
END IF;
END

tgr_station_parameter_deleted_date
BEGIN
IF NEW.deleted timestamp IS NOT NULL THEN
DELETE FROM station parameter min WHERE station parameter id=NEW.id;
END IF;
END
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tgr_station_parameter_audit_insert
BEGIN

DECLARE sid INT DEFAULT NULL;
DECLARE spid INT DEFAULT NULL;

SELECT station id FROM “station parameter’ WHERE id=NEW.station parameter id INTO
sid;

IF sid IS NOT NULL THEN
SELECT station parameter id FROM “station parameter min’ WHERE
station parameter id=NEW.station parameter id INTO spid;

IF (spid IS NULL) THEN

INSERT INTO station parameter min
(station parameter id,station id,code,visibility,name,station parameter audit id)

VALUES (NEW.station parameter id,sid,NEW.code,NEW.visibility, NEW.name,NEW.1id

)i
ELSE

UPDATE station parameter min SET code =
NEW.code, name=NEW.name, station id=sid,station parameter audit id=NEW.id,visibilit
y=NEW.visibility WHERE station parameter id=spid;

END IF;
END IF;
END

tgr_wa_observation_insert

BEGIN

DECLARE stationParameterId INT DEFAULT NULL;

DECLARE latestObservationTime DATETIME DEFAULT NULL;

SET time zone = "+00:00";
SELECT station parameter id,latest obs time FROM ‘wa latest observation® WHERE
station parameter id=NEW.station parameter id INTO
stationParameterId, latestObservationTime;
IF (stationParameterId IS NULL) THEN
IF (NEW.severity!=1) THEN

INSERT INTO ‘wa_latest observation’
(wa_last observation id,wa latest observation id,station parameter id, last severi
ty,last obs time,last obs value,latest severity,latest obs time,latest obs value,
last error observation id,last error obs time,last error obs value) VALUES

(NEW.id,NEW.id, NEW.station parameter id,NEW.

severity,NEW.obs time,NEW.obs value,NEW.severity,NEW.obs time,NEW.obs value,NULL,
NULL, NULL) ;
ELSE

INSERT INTO ‘wa_latest observation’
(wa_last observation id,wa latest observation id,station parameter id,last severi
ty,last obs time,last obs value,latest severity,latest obs time,latest obs value,
last error observation id,last error obs time,last error obs value) VALUES

(NULL, NULL,NEW.station parameter id, NULL,NUL

L,NULL, NULL, NULL, NULL, NEW. id, NEW.obs time,NEW.obs value);
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END IF;
ELSE
IF NEW.severity!=1 THEN
IF (latestObservationTime = NEW.obs time) THEN
UPDATE "wa_latest observation® SET
wa_last_observation id=NEW.id,
last severity=NEW.severity,
last obs time = NEW.obs time,
last obs value = NEW.obs value,
latest severity=NEW.severity,
latest obs value=NEW.obs value
WHERE station parameter id=NEW.station parameter id;
ELSEIF (latestObservationTime < NEW.obs time) THEN
UPDATE ‘wa_latest_observation® SET
last severity=NEW.severity,
wa_ last observation id=NEW.id,
last obs time = NEW.obs time,
last obs value = NEW.obs value,
latest severity=NEW.severity,
wa latest observation id=NEW.id,
latest obs time =NEW.obs time,
latest obs value=NEW.obs value
WHERE station parameter id=NEW.station parameter id;
ELSE
UPDATE “wa latest observation® SET
wa_ last observation id=NEW.id,
last severity=NEW.severity,
last obs time = NEW.obs time,
last obs value = NEW.obs value
WHERE station parameter id=NEW.station parameter id;
END IF;
ELSE
UPDATE “wa_ latest observation® SET
last error observation id=NEW.id,
last error obs time=NEW.obs time,
last _error obs value=NEW.obs value
WHERE station parameter id=NEW.station parameter id;
END IF;
END IF;
END

6. tgr_wa_observation_update
BEGIN

DECLARE lastInsertId BIGINT DEFAULT NULL; DECLARE stationParameterId INT DEFAULT
NULL;
DECLARE latestObservationTime DATETIME DEFAULT NULL;

SET time zone = "+00:00";
SELECT station parameter id,latest obs time FROM ‘wa latest observation’
WHERE station_parameter id=NEW.station parameter_id INTO
stationParameterId, latestObservationTime;
IF (stationParameterId IS NULL) THEN
IF (NEW.severity!=1) THEN
INSERT INTO “wa latest observation®
(wa_last observation id,wa latest observation id,station parameter id,last severity, last
_obs_time,last obs value,latest severity,latest obs time,latest obs value,last error obs
ervation id,last error obs time,last error obs value) VALUES
(NEW.id,NEW.1id,NEW.station parameter id
,NEW.severity,NEW.obs time,NEW.obs value,NEW.severity,NEW.obs time,NEW.obs value,NULL, NU
LL,NULL) ;
ELSE
INSERT INTO “wa latest observation®
(wa_last observation id,wa latest observation id,station parameter id,last severity, last
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_obs_time,last obs value,latest severity,latest obs time,latest obs value,last error obs
ervation id,last error obs time,last error obs value) VALUES

(NULL,NULL,NEW.station parameter id,NUL
L, NULL, NULL, NULL, NULL, NULL, NEW. id, NEW.obs time,NEW.obs value);

END IF;

ELSE
IF NEW.severity!=1 THEN
IF (latestObservationTime = NEW.obs time) THEN
UPDATE ‘wa_latest observation® SET
wa_last_observation id=NEW.id,
last severity=NEW.severity,
last_obs_time = NEW.obs time,
last obs value = NEW.obs value,
latest severity=NEW.severity,
latest obs value=NEW.obs value
WHERE station parameter id=NEW.station parameter id;
ELSEIF (latestObservationTime < NEW.obs time) THEN
UPDATE ‘wa latest observation® SET
last severity=NEW.severity,
wa last observation id=NEW.id,
last obs time = NEW.obs time,
last obs value = NEW.obs value,
latest severity=NEW.severity,
wa_ latest observation id=NEW.id,
latest obs time =NEW.obs time,
latest obs value=NEW.obs value
WHERE station parameter id=NEW.station parameter id;
ELSE
UPDATE “wa_ latest observation® SET
wa_ last observation id=NEW.id,
last severity=NEW.severity,
last obs time = NEW.obs time,
last obs value = NEW.obs value
WHERE station parameter id=NEW.station parameter id;
END IF;
ELSE
UPDATE “wa_ latest observation® SET
last error observation id=NEW.id,
last error obs time=NEW.obs time,
last _error obs value=NEW.obs value
WHERE station parameter id=NEW.station parameter id;
END IF;
END IF;

IF NEW.transfer to audit=1 THEN

INSERT INTO wa observation audit
(wa observation id,raw log id,station parameter id,obs time,obs value,severity,data sour
ce id,user id,processing start time,processing end time,log time,is processed)
VALUES (OLD.id,OLD.raw_log id,OLD.station paramete
r id,OLD.obs time,OLD.obs value,OLD.severity,OLD.data source id,OLD.user id,OLD.processi
ng start time,OLD.processing end time,UTC TIMESTAMP(),OLD.is processed);
SET lastInsertId = LAST_INSERT_ID();

INSERT INTO “wa observation audit rule executed’
(wa observation audit id,wa rule id,rule type,severity,rule failure,processing start tim
e,processing end time, status)

SELECT
lastInsertId,wa rule id,rule type,severity,rule failure,processing start time,processing

_end time,status FROM "wa observation rule executed’
WHERE wa observation id= OLD.id;

DELETE FROM "wa_observation_rule executed’ WHERE wa_observation_id= OLD.id;

END IF;
END
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SN | Component Language Description
1 DMS (frontend) GWT (?) user interface for Data Management
System
2 DMS (backend) PHP (?) business process (insert,update,delete)
BULL (rts build php operation in DMS
framework)
3 QC Engine PHP (?) run rules on data
(Scheduler)
4 Aggregation Engine PHP (?) run aggregation rule on data
(Scheduler)
5 | Alert Engine (Email) PHP (?) send email alert

(Scheduler)

Flow Chart of DMS

DMS is a tool to configure the data management system.lt is the place when we configure station its
parameter and define rules on these parameters.This tool includes two component

the frontend and the backend.The frontend user interface is developed in GWT and the backend
interface is developed in PHP.Front end servers user to insert,update and delete the configuration,
whereas the backend provides the frontend the data required to present to the user.Backend is also
responsible for saving,updating and deleting the configuration as supplied by the user through
frontend interface.Apart from the configuration this system can be used to view,upload and
manipulate the data received in DMS.
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Flow Chart QC Engine
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I Check in table “wa_observation”
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Flow Chart Aggregation Engine
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Alert Engine (Email)

QC Engine Aggregation Engine

Generate alert

Email Queue Email Queue
Table “email_queue” Table “email_queue_msg”
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—
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Update table “email_queue”
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